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ネットワーク設定の概要
ネットワーク全体のデフォルトになるネットワーク設定を作成できます。ネットワーク内の設

定を定義可能な主なエリアは次の 2つです。

• [Global settings]：ここで定義されている設定はネットワーク全体に適用されます。DHCP、
DNS、AAA、NTPなどのサーバー、IPアドレスプール、デバイスクレデンシャルプロ
ファイル、Syslog、トラップ、Netflowなどのテレメトリの設定が含まれます。

• [Site settings]：ここで定義されている設定はグローバル設定をオーバーライドします。ま
た、サーバー、IPアドレスプール、デバイスのログイン情報プロファイルの設定を含める
ことができます。

アクティブなファブリックで使用されているネットワーク設定の変更はサポートされていませ

ん。それらのネットワーク設定には、サイト階層、IPプールの名前変更など複数の機能が含ま
れます。

（注）

ネットワークの設定

1



一部のネットワーク設定は、デバイスの可制御性機能を使用してデバイスに自動的に設定でき

ます。Cisco DNA Centerによるデバイスの設定または更新時に、トランザクションがCisco DNA
Centerの監査ログにキャプチャされます。監査ログを使用すると、変更を追跡し、問題をトラ
ブルシューティングするのに役立ちます。

（注）

[Design] > [Network Settings]の順に選択して該当するタブをクリックし、次のグローバルネッ
トワーク設定を定義できます。

• AAA、DHCP、DNSサーバーなどのネットワークサーバー：詳細については、グローバル
ネットワークサーバーの設定（4ページ）を参照してください。

• CLI、SNMP、HTTP（S）などのデバイスクレデンシャル：詳細については、グローバル
CLIクレデンシャルの設定（4ページ）、グローバル SNMPv2cログイン情報の設定（5
ページ）、グローバル SNMPv3クレデンシャルの設定（6ページ）、およびグローバル
HTTPSクレデンシャルの設定（8ページ）を参照してください。

• IPアドレスプールの詳細については、IPアドレスプールを設定する（14ページ）を参照
してください。

• SSID、ワイヤレスインターフェイス、および無線周波数プロファイルなどのワイヤレス
設定：詳細については、グローバルワイヤレス設定の構成（20ページ）を参照してくだ
さい。

•テレメトリを使用して、syslog、SNMP、NetFlowコレクタサーバーなどのグローバルテレ
メトリ設定を構成します。

Cisco ISEまたはその他の AAAサーバーの追加
Cisco Identity Services Engine（ISE）サーバーまたはその他の同様の AAAサーバーを、ネット
ワーク、クライアント、およびエンドポイント認証のためにサイトまたはグローバルレベルで

定義することができます。ネットワーク認証では、RADIUSおよび TACACSプロトコルがサ
ポートされています。クライアントとエンドポイント認証では、RADIUSのみがサポートされ
ます。Cisco DNA Centerあたり、1つの Cisco ISEのみサポートされます。

マルチ ISE設定をサポートするために、RADIUSまたは TACACSサーバーグループの下に送
信元インターフェイスを設定できます。各 Cisco ISE ISEクラスタには独自のサーバーグルー
プがあります。RADIUSサーバーと TACACSサーバーに使用される送信元インターフェイス
は、次のように決定されます。

•デバイスに Loopback0インターフェイスが設定されている場合、Loopback0は送信元イン
ターフェイスとして設定されます。

•それ以外の場合は、Cisco DNA Centerを管理 IPとして使用するインターフェイスが送信元
インターフェイスとして設定されます。
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あるサイトに Cisco ISEサーバーを設定すると、サイトに割り当てられているデバイスは、対
応する Cisco ISEサーバーで、自動的に a /32マスクに更新されます。その後、Cisco ISEでこ
れらのデバイスに変更が行われると、Cisco DNA Centerに自動的に送信されます。

FIPSモードの展開の場合、共有秘密は、共有秘密、キーラップ、およびメッセージ認証コード
キーで構成されます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Network]。

ステップ 2 [サーバーの追加（Add Servers）]をクリックして AAAサーバーを追加します。

ステップ 3 [サーバーの追加（Add Servers）]ウィンドウで、[AAA]チェックボックスをオンにし、[OK]をクリックし
ます。

ステップ 4 AAAサーバーをネットワークユーザー、クライアント/エンドポイントユーザー、またはその両方に設定
します。

ステップ 5 [Network]または [Client/Endpoint]チェックボックスをオンにし、AAAサーバーのサーバーとプロトコルを
設定します。

ステップ 6 認証と認可のための [Servers]を選択します（[ISE]または [AAA]）。

• [ISE]を選択した場合は、次のように設定します。

• [ネットワーク]ドロップダウンリストから、Cisco ISEサーバーの IPアドレスを選択します。
[Network]ドロップダウンリストには、Cisco DNA Centerのホームページの [System Settings]に登
録されている、Cisco ISEサーバーのすべての IPアドレスが含まれています。Cisco ISEの IPを選
択すると、選択した Cisco ISEのポリシーサービスノード（PSN）の IPアドレスを持つプライマ
リおよび追加 IPアドレスのドロップダウンリストが表示されます。AAAサーバーの IPアドレス
を入力することも、[IP Address (Primary)]と [IP Address (Additional)]ドロップダウンリストから
PSN IPアドレスを選択することもできます。

• [Protocol]を選択します（[RADIUS]または [TACACS]）。

特定のワイヤレスコントローラの物理サイトと管理サイトのAAA設定が一致する必要
があります。一致しない場合、プロビジョニングは失敗します。

（注）

• [AAA]を選択した場合は、次のように設定します。

• AAAサーバーの IPアドレスを入力することも、[IP Address（Primary]および [IP Address（Additional]
ドロップダウンリストから IPアドレスを選択することもできます。これらのドロップダウンリス
トには、[System Settings]で登録されている Cisco ISE以外の AAAサーバーが含まれています。

ステップ 7 [Save]をクリックします。
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グローバルネットワークサーバーの設定
ネットワーク全体のデフォルトになるグローバルネットワークサーバーを定義することがで

きます。

サイト固有の設定を定義することで、サイトのグローバルネットワーク設定を上書きできま

す。

（注）

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Network]の順に選択します。

ステップ 2 [DHCP Server]フィールドに、DHCPサーバーの IPアドレスを入力します。

プラスアイコンをクリックすると、IPv4アドレスと IPv6アドレスの両方を入力できます。

IPアドレスプールを作成するには、少なくとも 1つのDHCPサーバーを定義する必要がありま
す。

（注）

ステップ 3 [DNS Server]フィールドに、DNSサーバーのドメイン名を入力します。

プラスアイコンをクリックすると、IPv4アドレスと IPv6アドレスの両方を入力できます。

IPアドレスプールを作成するために、少なくとも 1つの DNSサーバーを定義する必要があり
ます。

（注）

ステップ 4 [Save]をクリックします。

グローバルデバイスクレデンシャルの概要
「グローバルデバイスクレデンシャル」とは、ネットワーク内のデバイスに関する情報を検

出して収集するためにCisco DNA Centerで使用される共通のCLI、SNMP、およびHTTPSクレ
デンシャルを指します。Cisco DNA Centerは、グローバルクレデンシャルを使用して設定済み
デバイスクレデンシャルを共有するネットワーク内のデバイスを認証し、アクセスします。グ

ローバルデバイスクレデンシャルの追加、編集、および削除することができます。また、グ

ローバルサイトまたは特定のサイトにクレデンシャルを関連付けることもできます。

グローバル CLIクレデンシャルの設定
最大 10のグローバル CLIクレデンシャルを設定して保存できます。

ステップ 1 [Design] > [Network Settings] > [Device Credentials]。メニューアイコン（ ）をクリックして、 > >
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ステップ 2 左側の階層ツリーから、[Global]を選択します。

ステップ 3 [CLI Credentials]エリアで、[Add]をクリックします。

ステップ 4 次のフィールドに情報を入力します。

表 1 : CLIクレデンシャル

説明フィールド

CLIクレデンシャルを説明する名前または語句。Name/Description

ネットワーク内のデバイスの CLIにログインするために使用する名前。Username

ネットワーク内のデバイスの CLIにログインするために使用されるパスワード。

セキュリティ上の理由から、確認のためにパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Password

CLIで高い権限レベルに移るために使用するパスワード。ネットワークデバイス
で必要な場合にのみ、このパスワードを設定します。

セキュリティ上の理由から、有効なパスワードを再入力します。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Enable Password

ステップ 5 [Save]をクリックします。

サイトにクレデンシャルを適用するには、左側の階層ツリーからサイトを選択し、クレデンシャルの横に

あるボタンを選択して、[Save]をクリックします。

ステップ 6 既存のクレデンシャルを変更する場合は、[Now]で今すぐクレデンシャルを更新するか、後で更新するス
ケジュールを設定するかを選択します。

グローバル SNMPv2cログイン情報の設定
ネットワークデバイスをモニタおよび管理するために、グローバル SNMPv2cクレデンシャル
を設定できます。

Cisco DNA Centerは、FIPSモードが有効になっている場合、SNMPv2cデバイスクレデンシャ
ルをサポートしません。代わりに、SNMPv3クレデンシャルを指定する必要があります。

（注）

始める前に

ネットワークの SNMP情報は必須です。

ネットワークの設定
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ステップ 1 [設計（Design）] > [ネットワーク設定（Network Settings）] > [デバイスクレデンシャル（Device
Credentials）]。メニューアイコン（ ）をクリックして、 > >

ステップ 2 左側の階層ツリーから、[Global]を選択します。

ステップ 3 [SNMP Credentials]エリアで、[Add]をクリックします。

ステップ 4 [タイプ（Type）]で、[SNMP v2c]をクリックし、次の情報を入力します。

表 2 : SNMPv2cのクレデンシャル

説明フィールド

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [Read Community]：デバイスに SNMP情報を表示する目的のみに使用される
読み取り専用のコミュニティ文字列パスワード。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Read

• [Name/Description]：追加している SNMPv2c設定の名前または説明。

• [Write Community]：デバイス上の SNMP情報を変更するために使用される書
き込みコミュニティ文字列。

パスワードはセキュリティ上の理由から暗号化されており、この設定

では表示されません。

（注）

Write

ステップ 5 [Save]をクリックします。

ステップ 6 既存のクレデンシャルを変更する場合は、[Now]で今すぐクレデンシャルを更新するか、後で更新するス
ケジュールを設定するかを選択します。

グローバル SNMPv3クレデンシャルの設定
ネットワークデバイスをモニタおよび管理するために、グローバルSNMPv3クレデンシャルを
設定できます。

始める前に

ネットワークの SNMP情報は必須です。

ステップ 1 [Design] > [Network Settings] > [Device Credentials]。メニューアイコン（ ）をクリックして、 > >

ステップ 2 左側の階層ツリーから、[Global]を選択します。

ステップ 3 [SNMP Credentials]エリアで、[Add]をクリックします。

ネットワークの設定
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ステップ 4 [Type]で、[SNMP v3]をクリックし、次の情報を入力します。

表 3 : SNMPv3のクレデンシャル

説明フィールド

追加した SNMPv3設定の名前または説明。Name/Description

SNMPv3設定に関連付けられている名前。Username

SNMPメッセージを必要とするセキュリティレベル。次のいずれかのモードを選択
します。

• [noAuthNoPriv]：認証または暗号化を提供しません。

• [AuthNoPriv]：認証を提供しますが、暗号化は提供しません。

• [AuthPriv]：認証と暗号化の両方を提供します。

Mode

使用する認証タイプ（認証モードとして [AuthPriv]または [AuthNoPriv]を選択した
場合に有効になります）。次のいずれかの認証タイプを選択します。

• [SHA]：HMAC-SHAに基づく認証

• [MD5]：HMAC-MD5に基づく認証

Auth Type

SNMPv3を使用するデバイスから情報にアクセスする際に使用するSNMPv3パスワー
ド。これらのパスワード（またはパスフレーズ）は、8文字以上にする必要がありま
す。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あるい
はパスフレーズ）は少なくとも12文字以上である必要があります。
ワイヤレスコントローラのパスワードの最小要件を必ず確認してく

ださい。パスワードに必要な最低限の文字数が守られないと、デバ

イスではCisco DNA Centerによる検出、監視、管理が行われなくな
ります。

•パスワードはセキュリティ上の理由から暗号化されており、この設
定では表示されません。

Auth Password

プライバシータイプ。（認証モードとして [AuthPriv]を選択すると有効になりま
す）。次のいずれかのプライバシータイプを選択します。

• [DES]：CBC DES-56規格に基づく認証に DES 56-bit暗号化を追加。

• [AES128]：暗号化の CBCモード AES。

• [None]：プライバシー設定はありません。

Privacy Type

ネットワークの設定
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説明フィールド

DESまたは AES128暗号化をサポートしているデバイスで交換されるメッセージを
暗号化するための秘密鍵を生成するために使用されるSNMPv3プライバシーパスワー
ド。パスワード（またはパスフレーズ）は、8文字以上にする必要があります。

（注） •一部のシスコワイヤレスコントローラでは、パスワード（あるい
はパスフレーズ）は少なくとも12文字以上である必要があります。
ワイヤレスコントローラのパスワードの最小要件を必ず確認してく

ださい。パスワードに必要な最低限の文字数が守られないと、デバ

イスではCisco DNA Centerによる検出、監視、管理が行われなくな
ります。

•パスワードはセキュリティ上の理由から暗号化されており、この設
定では表示されません。

Privacy Password

ステップ 5 [Save]をクリックします。

ステップ 6 既存のクレデンシャルを変更する場合は、デバイスで新しいクレデンシャルを今すぐ更新するか、後で更
新をスケジュールすることが求められます。

•新しいクレデンシャルを今すぐ更新するには、[Now]ラジオボタンをクリックし、[Apply]をクリック
します。

•後で更新をスケジュールするには、[Later]ラジオボタンをクリックして更新の日時を定義し、[Apply]
をクリックします。

[Time Zone]チェックボックスを使用して、サイトのタイムゾーンに従って更新を行うか、
特定のタイムゾーンに従って更新を行うかを指示します。

（注）

グローバル HTTPSクレデンシャルの設定

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Device Credentials]。

ステップ 2 左側の階層ツリーから、[Global]を選択します。

ステップ 3 [HTTPS Credentials]エリアで、[Add]をクリックします。

ステップ 4 次の情報を入力します。

表 4 : HTTPSクレデンシャル

説明フィールド

設定している HTTPSクレデンシャルのタイプを指定します。有効なタイプは、
[Read]または [Write]です。

[Type]

ネットワークの設定
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説明フィールド

最大 10つの HTTPS読み取りクレデンシャルを設定できます。

• [Name/Description]：追加している HTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワードは
セキュリティ上の理由から暗号化されており、この設定では表示されません。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する必
要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（< >）は使用できません。一部の Cisco IOS XE
デバイスでは、疑問符（?）を使用できないので注意してください。

Read

最大 10つの HTTPS書き込みクレデンシャルを設定できます。

• [Name/Description]：追加している HTTPSログイン情報の名前または説明。

• [Username]：HTTPS接続の認証に使用される名前です。

• [Password]：HTTPS接続の認証に使用されるパスワードです。パスワードは
セキュリティ上の理由から暗号化されており、この設定では表示されません。

• [Port]：HTTPSトラフィックに使用される TCP/UDPポートの番号です。デ
フォルトはポート番号 443（HTTPSの既知のポート）です。

パスワードは 7～ 128文字で指定します。次から少なくとも 1つずつ使用する必
要があります。

•小文字の英字（a～ z）

•大文字の英字（A～ Z）

•数字（0～ 9）

•特殊文字（: # _ * ?）–

パスワードにスペースや山カッコ（< >）は使用できません。一部の Cisco IOS XE
デバイスでは、疑問符（?）を使用できないので注意してください。

Write

ネットワークの設定
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ステップ 5 [Save]をクリックします。

ステップ 6 既存のクレデンシャルを変更する場合は、[Now]で今すぐクレデンシャルを更新するか、後で更新するス
ケジュールを設定するかを選択します。

グローバルデバイスのログイン情報の編集に関する注意事項

既存のグローバルデバイスクレデンシャルの編集に関する注意事項と制約事項は、次のとお

りです。

• Cisco DNA Centerグローバルデバイスクレデンシャルを編集、保存、および適用する際
は、次のプロセスが使用されます。

1. Cisco DNA Centerからローカル認証を持つデバイスにログイン情報がプッシュされま
す。ローカル認証では、ログイン情報の変更が適用され、Cisco DNA Centerはこれら
のログイン情報を使用してデバイスを管理します。

（AAAサーバーが継承または設定されたサイトにあるデバイスには、CiscoDNACenter
から CLIログイン情報の変更はプッシュされません。AAA認証では、ログイン情報
の変更は適用されません。Cisco DNA Centerは、同じログイン情報が AAAサーバー
に存在する場合にのみ、これらのログイン情報を使用してデバイスを管理します）

2. クレデンシャルがデバイスに正常にプッシュされると、Cisco DNA Centerは新しいク
レデンシャルを使用してデバイスに到達できることを確認します。

この手順に失敗すると、Cisco DNA Centerが新しいクレデンシャ
ルをデバイスにプッシュしていても、インベントリでは古いクレ

デンシャルを使用してデバイスが管理されます。この場合、既存

のログイン情報を更新すると、[Provision] > [Inventory]ウィンド
ウでデバイスが管理対象外であると示される可能性があります。

（注）

3. 新しいクレデンシャルを使用してデバイスに正常に到達すると、Cisco DNA Centerの
インベントリは、新しいクレデンシャルを使用してデバイスの管理を開始します。

•サイトには、SNMPv2cクレデンシャルと SNMPv3クレデンシャルを使用するデバイスを
含めることができます。SNMPv2cまたは SNMPv3のグローバルクレデンシャルを編集し
て保存すると、Cisco DNA Centerはその変更をデバイスにプッシュし、そのクレデンシャ
ルを有効にします。たとえば、SNMPv2cを使用するデバイスがあるのに、SNMPv3のグ
ローバルクレデンシャルを編集して保存すると、Cisco DNA Centerは関連付けられたサイ
トのすべてのデバイスに新しいSNMPv3のクレデンシャルをプッシュして、そのクレデン
シャルを有効にします。つまり、以前は SNMPv2cが有効になっていたデバイスを含め、
すべてのデバイスが SNMPv3を使用して管理されるようになります。
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•混乱が生じないようにするために、CLIログイン情報を編集する際は [User Name]を変更
してください。これにより、新しいCLIクレデンシャルが作成され、既存のCLIクレデン
シャルは変更されません。

グローバルデバイスクレデンシャルの編集

準備が整うまで、Cisco DNA Centerでクレデンシャルの変更を適用せずに、グローバルデバイ
スクレデンシャルを編集および保存できます。変更の適用を決定すると、Cisco DNA Center
は、変更したデバイスクレデンシャルを参照するすべてのサイトを検索し、すべてのデバイス

に変更をプッシュします。

新しいグローバルデバイスクレデンシャルを更新または作成できますが、Cisco DNA Center
はデバイスからクレデンシャルを削除することはありません。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Device Credentials]の順に選択
します。

ステップ 2 左側の階層ツリーから、[Global]を選択します。

ステップ 3 [Manage Credentials]をクリックし、変更するデバイスのログイン情報のチェックボックスをオンにして、
[Actions] > [Edit]の順に選択します。

ステップ 4 [Edit Credentials]ダイアログボックスで、必要な変更を加えて、[Save]をクリックします。

CLIパスワードログイン情報には、ASCII印刷可能文字（文字コード 32〜 127。
https://en.wikipedia.org/wiki/ASCII#Printable_charactersを参照）だけを使用できます。

（注）

ステップ 5 クレデンシャルタイルで、[Apply]をクリックします。

ステップ 6 [Apply Credentials]ダイアログボックスで、ログイン情報を今すぐ更新する（[Now]）か、後でスケジュー
ルするかを選択します。

ステップ 7 クレデンシャル変更のステータスを表示するには、[Provision] > [Network Devices] > [Inventory]の順に選
択します。

[クレデンシャルステータス（Credential Status）]列に、次のいずれかのステータスが表示されます。

• [Success]：Cisco DNA Centerはログイン情報の変更を正常に適用しました。

• [Failed]：Cisco DNA Centerはログイン情報の変更を適用できませんでした。失敗したログイン情報の
変更とその理由に関する追加情報を表示するには、アイコンの上にカーソルを重ねます。

• [Not Applicable]：ログイン情報はデバイスタイプに適用できません。

複数のクレデンシャル（CLI、SNMP、HTTPSなど）を編集して保存した場合、がいずれかのクレデンシャ
ルを適用できなかったときには、[クレデンシャルステータス（Credential Status）]列に [失敗（Failed）]と
表示されます。Cisco DNA Center失敗したログイン情報の変更に関する追加情報を表示するには、アイコ
ンの上にカーソルを重ねます。
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デバイスクレデンシャルのサイトへの関連付け

グローバルサイトを作成するサイトは、グローバルなデバイスのクレデンシャルを継承できま

す。または特定サイトの別のデバイスのクレデンシャルを作成することができます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Device Credentials]。

ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 [Manage Credentials]をクリックします。

ステップ 4 選択したサイトに関連付けるクレデンシャルを選択し、次に [Assign]をクリックします。

デバイスのログイン情報がサイトに正常に関連付けられたことを示す成功メッセージが、画面の下部に表

示されます。

デバイスクレデンシャルの管理

ログイン情報管理ワークフローでは、ログイン情報を作成または編集したり、割り当てたり、

デバイスに適用することができます。

ログイン情報は、グローバルサイト（[Global]）、または選択したサイト、建物、フロアに割
り当てられます。グローバルレベルでログイン情報を割り当てる場合、すべてのサイト、建

物、およびフロアは、グローバルレベルから設定を継承します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Device Credentials]の順に選
択します。

ステップ 2 [Global]または必要なエリア、建物、フロアを左側の階層ツリーから、。

ステップ 3 [Manage Credentials]をクリックします。
[Manage Credentials]ウィンドウが開きます。

ステップ 4 [Add]ドロップダウンリストから、ログイン情報のタイプ（CLI、HTTP（HTTPS）読み取り、SNMPv3
など）を選択します。

ステップ 5 [Add New Credentials]ウィンドウで、次の手順を実行します。

1. 必要なフィールドに情報を入力します。

2. [Assign credential to site]チェックボックスをオンにします。

ボックスがオフの場合、ログイン情報は作成されますが、どのサイトにも割り当てられ

ません。

（注）

3. [保存（Save）]をクリックします。

新しく作成したログイン情報が [Manage Credentials]ウィンドウに表示されます。

ステップ 6 割り当てるログイン情報を選択し、[Assign]をクリックします。

ネットワークの設定

12

ネットワークの設定

デバイスクレデンシャルのサイトへの関連付け



ステップ 7 ログイン情報を適用するには、次のいずれかを実行します。

•サイト階層全体にログイン情報を適用するには、[Manage Credentials]に移動し、目的のログイン情
報の [Actions]メニューにマウスカーソルを合わせて、[Apply]を選択します。

•特定のサイトだけにログイン情報を適用するには、左側の階層ペインで目的のサイトを選択し、そ
のログイン情報に対応するカードで [Assign]をクリックします。

ステップ 8 [Apply Credentials]ダイアログボックスで、ログイン情報を今すぐ更新する（[Now]）か、後でスケジュー
ルするかを選択します。

ログイン情報は、該当するすべてのサイトに適用されます。

まだ開始されていないログイン情報適用タスクは、再スケジュールすることができます。

ステップ 9 タスクのステータスを表示するには、次のいずれかを実行します。

• [Device Credentials]ウィンドウで、右上隅にある更新アイコンをクリックします。ログイン情報カー
ドの見出しの横にあるアイコンにマウスカーソルを合わせます。

• [Provision] > [Inventory]の順に選択します。[Credential Status]列にステータスが表示されます。

• [Activities] > [Audit Logs]の順に選択します。

ステップ 10 ログイン情報を編集するには、次の手順を実行します。

1. 対応するログイン情報の横にある編集アイコンをクリックします。

または、[Manage Credentials]ウィンドウで、ログイン情報名の横にある省略記号のアイコンにカーソ
ルを合わせて、[Edit]をクリックします。

2. [Edit Information]ウィンドウで、[OK]をクリックします。

3. [Edit Credentials]ウィンドウで必要な変更を加えます。

4. [保存（Save）]をクリックします。

ステップ 11 ログイン情報適用の開始日時を再スケジュールするには、次のいずれかの手順を実行します。

•グローバルにスケジュールされたタスク：[Manage Credentials]ウィンドウで、ログイン情報名の横
にある水平の省略記号のアイコンにカーソルを合わせて、[Apply]を選択してから、[Apply]をクリッ
クします。

•サイト、建物、またはフロアのメインページからスケジュールされたタスク：タスクが最初にスケ
ジュールされたサイト、建物、またはフロアに戻り、対応するログイン情報カードで [Apply]をク
リックします。

タイムゾーンは変更できません。（注）
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IPアドレスプールを設定する
Cisco DNA Center IPv4と IPv6のデュアルスタック IPプールがサポートされています。

IPv4および IPv6アドレスプールは手動で設定できます。

Cisco DNA Centerを外部 IPアドレスマネージャと通信するように設定することもできます。
詳細については、Cisco DNA Center管理者ガイドを参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 [Add]をクリックし、[Add IP Pool]ウィンドウの必須入力フィールドをすべて入力します。

Cisco DNA Centerが外部の IPアドレスマネージャと通信するように設定した場合、外部 IPアドレスマネー
ジャの既存の IPアドレスプールと重複する IPプールを作成することはできません。

ステップ 3 [Save]をクリックします。

新しく追加されたプールが IPアドレスプールテーブルに表示されます。IPv4または IPv6のアドレスプー
ルのみを表示する場合は、[SUBNET TYPE]領域で [IPv4]または [IPv6]オプションをクリックします。

IPアドレスプールを編集して、DHCPを変更すると、その IPアドレスプールを使用してデバ
イスを再設定する必要はありません。

（注）

IPアドレスマネージャから IPアドレスプールをインポートする
Bluecatまたは Infobloxから IPアドレスプールをインポートできます。

IPアドレスプールはサブプールを持つことができず、IPアドレスプールから割り当てられた
IPアドレスを持つことはできません。

（注）

外部 IPアドレスマネージャ（IPAM）と通信するには Cisco DNA Centerを設定する必要があり
ます。詳細については、Cisco DNA Center管理者ガイドを参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 [Actions]ドロップダウンリストから、[Import from IPAM Server]を選択し、必須フィールドに値を入力しま
す。

ステップ 3 CIDRを入力し、[Retrieve]をクリックして、インポートできる IPプールのリストを取得します。

ステップ 4 [Select All]をクリックするか、またはインポートする IPアドレスプールを選択して [Import]をクリックし
ます。
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CSVファイルから IPアドレスプールをインポートする
CSVファイルから IPアドレスプールをインポートできます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 [Actions]ドロップダウンリストから、[Import from CSV File]を選択します。

ステップ 3 [Download Template]をクリックして最新のサンプルファイルをダウンロードします。

ステップ 4 ファイルに IPアドレスプールを追加して、ファイルを保存します。

ステップ 5 次のアクションのいずれかを実行して、CSVファイルをアップロードします。

a) ドラッグアンドドロップエリアにファイルをドラッグアンドドロップします。

b) [クリックして選択（click to select）]が表示される場所をクリックしてファイルを選択します。

ステップ 6 [インポート (Import)]をクリックします。

IPアドレスプールの予約

始める前に

1つまたは複数の IPアドレスプールが作成されていることを確認します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 左側の階層ツリーから、サイトを選択します。

ステップ 3 [Reserve]をクリックして以下のフィールドに入力し、使用可能なグローバル IPアドレスプールのすべてま
たは一部を特定のサイト用に予約します。

• [IP Address Pool Name]：予約した IPアドレスプールの一意の名前。

• [Type]：IPアドレスプールのタイプ。LAN自動化の場合は、LANを選択します。次のオプションがあ
ります。

• [LAN]：該当するアンダーレイの LANインターフェイスに IPアドレスを割り当てます。

• [Management]：IPアドレスを管理インターフェイスに割り当てます。

• [Service]：IPアドレスをサービスインターフェイスに割り当てます。

• [WAN]：IPアドレスをWANインターフェイスに割り当てます。

• [Generic]：他のすべてのネットワークタイプで使用されます。

• [IP Address Space]：すべてまたは一部の IPアドレスを予約する IPv4および IPv6アドレスプール。

• CIDR Prefix/Number of IP Addresses：IP subnet and mask address used to reserve all or part of the global IP
address pool or the number of IP addresses you want to reserve. IPv6 IPプールの [CIDR Prefix]として \64を
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選択すると、[SLAAC]オプションがオンになります。（[SLAAC]が選択されている場合、デバイスは
DHCPサーバーを必要とせずに、自動的に IPアドレスを獲得します）。

• [Gateway]：ゲートウェイ IPアドレス。

• [DHCP Servers]：DHCPサーバーの IPアドレス。

• [DNS Servers]：DNSサーバーのアドレス。

ステップ 4 [予約（Reserve）]をクリックします。

IPv4と IPv6の両方のアドレスプールを予約している場合（ファブリックがデュアルスタック IPプールで
プロビジョニングされている場合）で、IPv6プールがすでにVNに接続されているときは、シングルスタッ
ク IPプールに戻すことはできません。

ただし、IPv6プールがVNに接続されていない場合は、デュアルスタック IPv6プールからシングルスタッ
ク IPv4プールにダウングレードできます。シングルスタックにダウングレードするには、[IP Address Pools]
ウィンドウで、デュアルスタック IPプールの [Edit]をクリックします。[Edit IP Pool]ウィンドウで、[IPv6]
チェックボックスをオフにして、[Save]をクリックします。

IPアドレスプールの編集

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 すべての IPアドレスプールを一括で編集するには、次の手順を実行します。

a) [Actions]ドロップダウンリストから、[Edit All]を選択します。
b) [Warning]メッセージで [Yes]をクリックします。
c) [Edit IP Pool]ウィンドウで、必要な変更を行い、[Save]をクリックします。

ステップ 4 目的の IPアドレスプールのみを編集するには、次の手順を実行します。

a) 目的の IPアドレスプールを選択し、[Actions]ドロップダウンリストから [Edit Selected]をクリックし
ます。

選択した IPアドレスプールに対応する [Edit]をクリックすることもできます。

b) [Edit IP Pool]ウィンドウで、必要な変更を行い、[Save]をクリックします。

IPアドレスプールの削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]の順に選択し
ます。
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ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 すべての IPアドレスプールを一括で削除するには、次の手順を実行します。

a) [Actions]ドロップダウンリストから、[Delete All]を選択します。
b) [Warning]メッセージで [Yes]をクリックします。

ステップ 4 目的の IPアドレスプールのみを削除するには、次の手順を実行します。

a) 目的の IPアドレスプールを選択し、[Actions]ドロップダウンリストから [Delete Selected]をクリックし
ます。

選択した IPアドレスプールに対応する [Delete]をクリックすることもできます。

b) [Warning]メッセージで [Yes]をクリックします。

IPアドレスプールの複製
サイトレベルで既存の IPアドレスプールを複製できます。IPアドレスプールを複製すると、
DHCPサーバーと DNSサーバーの IPアドレスが自動的に入力されます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 目的の IPアドレスプールを見つけ、[Actions]エリアで [Clone]をクリックします。

ステップ 4 [Clone IP Pool]ウィンドウで、次の手順を実行します。

a) 必要に応じて、プール名を編集します（タイプ、IPアドレス空間、またはグローバルプール値は、複
製元のプールから継承されるため編集できません）。

b) 必要に応じて、CIRDプレフィックス値を編集します。
c) [Clone]をクリックします。

IPアドレスプールのリリース
サイトレベルで予約されているシングルスタックおよびデュアルスタックプールをリリースで

きます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]。

ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 すべての IPアドレスプールを一括でリリースするには、次の手順を実行します。

a) [Actions]ドロップダウンリストから、[Release All]を選択します。
b) [Warning]メッセージで [Yes]をクリックします。
c) プロンプトで [Release]をクリックします。
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ステップ 4 目的の IPアドレスプールのみをリリースするには、次の手順を実行します。

a) 目的の IPアドレスプールを選択し、[Actions]ドロップダウンリストから [Release Selected]をクリック
します。

b) プロンプトで [Release]をクリックします。

IPアドレスプールの表示
この手順では、テーブルビューとツリービューで 10個以上の IPアドレスプールを表示する方
法を示します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [IP Address Pools]の順に選択
します。

ステップ 2 左側の階層ツリーから、必要なサイトを選択します。

ステップ 3 トグルボタンを使用して、テーブルビューとツリービューを切り替えます。

• IPアドレスプールが10個以上の場合は、デフォルトではテーブルビューにプールが表示されます。

• IPアドレスプールが 10個未満の場合は、デフォルトではツリービューにプールが表示されます。

テーブルマップビューとツリーマップビューの切り替えは、UIでのユーザーの選択ではなく
プール数に基づきます。

ツリービューは、グローバルプールとサイトプールに適用されます。

（注）

ステップ 4 [IP Address Pools]テーブルビューには、[Name]、[Type]、[IPv4 Subnet]、[IPv4 Used]、[IPv6 Subnet]、[IPv6
Used]、および [Actions]に基づいて IPアドレスプールのリストが表示されます。

• [IPv4 Used]および [IPv6 Used]の横にある [i]アイコンにカーソルを合わせます。[IPv4
Used]、[IPv6 Used]、[Free]、[Unassignable]、[Assigned]、および [Default Assigned]の IPア
ドレスプールに関する詳細情報がツールチップに表示されます。

• [IPv4]列と [IPv6]列で、特定の IPアドレスプールに対応する [IPv4]と [IPv6]の使用率の
横にある [i]アイコンにカーソルを合わせます。ツールチップには、[Free]、[Unassignable]、
[Assigned]、および [Default Assigned]の IPアドレスプールの割合が表示されます。

（注）

ステップ 5 テーブルビューで [IPv4]または [Dual-Stack]のアドレスプールのみを表示する場合は、[Sbunet Type]エリ
アで [IPv4 only]または [Dual-Stack]オプションをクリックします。

ステップ 6 ツリービューで、目的の IPアドレスプールにカーソルを合わせてクリックすると、次の情報を含むスラ
イドインペインが表示されます。

• IPアドレスプールのサブネットタイプ。

•それぞれのプール下にある使用可能な IPアドレスと [Pool CIDR]、[Gateway]、[DHCP Server(s)]、お
よび [DNS Server(s)]の割合。
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•各プールで使用されている IPアドレスの割合。

ステップ 7 [Used]エリアで、[Assigned]をクリックすると、[Device Name]、[IP Address]、および [Site]に基づいて
フィルタ処理されたデバイスに割り当てられた IPアドレスのリストが表示されます。

ステップ 8 [Unassignable]をクリックすると、[Device Name]、[IP Address]、および [Site]に基づいてフィルタ処理さ
れたデバイスに割り当てることができない未割り当て IPアドレスのリストが表示されます。

ステップ 9 [Edit]をクリックして、IPアドレスプールを編集します。

ステップ 10 [Release]をクリックして、IPアドレスプールを解放します。

•グローバルプールのサイドバーでは、特定のプールについて、すべての子プールにおけ
る使用状況を確認できます。

•グローバル IPアドレスプールとサイト IPアドレスプールには、ブロックリストに登録
された IPアドレスを設定できます。

•サブプールにはブロックリストに登録された IPアドレスを含めることはできません。

• Cisco DNA Centerは、ブロックリストに登録された IPアドレスが含まれている場合、
CIDRアドレスプールの IPアドレスプール作成要求を拒否します。

•次の空き IPアドレスプール要求では、Cisco DNA Centerはブロックリストに登録さ
れた IPアドレスをスキップして、次の IPアドレス空きプールを見つけます。

（注）

ステップ 11 （オプション）テーブルデータをエクスポートするには、サイドバーで [Export]をクリックします。

サービスプロバイダプロファイルの設定
特定のWANプロバイダのサービスクラスを定義するサービスプロバイダ（SP）プロファイ
ルを作成することができます。サービスモデルには、4クラス、5クラス、6クラス、および 8
クラスを定義できます。SPプロファイルの作成後、アプリケーションポリシーの範囲内（必
要に応じてインターフェイスのサブラインレート設定を含む）のアプリケーションポリシーと

WANインターフェイスにそのプロファイルを割り当てることができます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [SP Profiles]の順に選択します。

ステップ 2 [Qos]領域で、[Add]をクリックします。

ステップ 3 [Profile Name]フィールドに、SPプロファイルの名前を入力します。

ステップ 4 [WAN Provider]ドロップダウンリストから、新しいサービスプロバイダを入力するか、既存のプロバイダ
を選択します。

ステップ 5 [Model]ドロップダウンリストから、クラスモデル（[4 class]、[5 class]、[6 class]、および [8 class]）のいず
れかを選択します。
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これらのクラスの詳細については、サービスプロバイダのプロファイルを参照してください。

グローバルワイヤレス設定の構成
グローバルワイヤレスネットワーク設定には、サービスセット識別子（SSID）、ワイヤレス
インターフェイス、RF、およびセンサーの設定が含まれます。

ワイヤレスセンサーデバイスプロファイルを作成できるのは、Cisco Aironet 1800sアクティブ
センサーデバイスに対してのみです。

（注）

エンタープライズワイヤレスネットワーク用 SSIDの作成
次の手順では、エンタープライズワイヤレスネットワークにSSIDを設定する方法を説明して
います。

SSIDは、グローバルレベルで作成されます。サイト、ビルディング、フロアは、グローバル
レベルから設定が継承されます。

（注）

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [SSID]テーブルで、[Add]の上にカーソルを合わせて、[Enterprise]を選択します。

ステップ 5 [Wireless SSID]ワークフローで、[Basic Settings]のセットアップを完了します。

a) [Sensor]トグルボタンが使用可能な場合は、無効になっていることを確認します。
b) [Wireless Network Name (SSID)]フィールドに、ワイヤレスネットワークの一意の名前を入力します。
c) [WLAN Profile Name]フィールドに、WLANプロファイルの名前を入力します。

Cisco DNA CenterはWLANプロファイル名に基づいて、Cisco Catalyst 9800シリーズワイヤレスコ
ントローラのポリシープロファイル名を自動的に生成します。

d) [Wireless Option]の設定で、次のいずれかのオプションボタンをクリックします。

• [Multi band operation（2.4 GHz, 5 GHz, 6GHz）]：WLANは 2.4 GHz、5 GHz、および 6 GHz用に
作成され、バンドセレクトは無効になっています。

• [Multi band operation with band select]：WLANは 2.4 GHz、5 GHz、および 6 GHz用に作成され、
バンドセレクトは有効になっています。
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• [5 GHz only]：WLANが 5 GHz用に作成され、バンドセレクトは無効になっています。

• [2.4 GHz only]：WLANが 2.4 GHz用に作成され、バンドセレクトは無効になっています。

• [6GHz Only]：WLANは 6 GHz用に作成され、バンドセレクトは無効になっています。

e) [Primary Traffic Type]ドロップダウンリストから、次のいずれかのオプションを選択します。

• [VoIP (Platinum)]：ワイヤレスネットワークの QoSは、ワイヤレス音声およびデータトラフィッ
ク用に最適化されています。

• [Video (Gold)]：ワイヤレスネットワークのQoSはビデオトラフィック用に最適化されています。

• [Best Effort (Silver)]：ワイヤレスネットワークの QoSは、ワイヤレスデータトラフィック用に
のみ最適化されています。

• [Non-real Time (Bronze)]：ワイヤレスネットワークのQoSは、低帯域幅の使用に最適化されてい
ます。

f) [SSID STATE]設定では、トグルボタンをクリックして、次の設定を有効または無効にします。

• [Admin Status]：このトグルボタンを使用して、APの無線をオンまたはオフにします。[Admin
Status]が無効になっている場合、APはワイヤレスコントローラに関連付けられたままで、ア
クセス可能であり、APには引き続きライセンスが必要です。

• [Broadcast SSID]：範囲内のすべてのワイヤレスクライアントに対してSSIDの可視性を有効また
は無効にするには、このトグルボタンを使用します。

ステップ 6 [Security Settings]の設定を完了します。

a) [Level of Security]で、このネットワークの暗号化および認証タイプを選択します。サイト、ビルディ
ング、およびフロアは、グローバル階層から設定を継承します。サイト、ビルディング、またはフ

ロアレベルでセキュリティレベルをオーバーライドできます。

• [Enterprise]：それぞれのチェックボックスをオンにすることで、[WPA2]と [WPA3]の両方のセ
キュリティ認証を設定できます。

Wi-Fi Protected Access（WPA2）では、Counter Modeと暗号ブロック連鎖メッセージ
認証コードプロトコルを使用した、より強力な高度暗号化規格アルゴリズム

（AES-CCMP）が使用されます。

WPA3は、WPAの最新バージョンです。これは、Wi-Fiネットワークの認証と暗号
化を提供するプロトコルとテクノロジーのスイートです。WPA3エンタープライズ
は、センシティブデータネットワーク用に、より高いグレードのセキュリティプロ

トコルを提供します。

2.4 GHzおよび 5 GHz帯域のみを使用するマルチバンド操作の場合、WPA2を有効に
する必要があります（WPA3はオプションです）。2.4 GHz、5 GHz、および 6 GHz
帯域を使用したマルチバンド動作の場合、Cisco IOS 17.7以降を搭載したデバイスで
6 GHz帯域を動作するには、WPA3を有効にしWPA2を無効にする必要があります。

（注）
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• [Personal]：それぞれのチェックボックスをオンにすることで、[WPA2]と [WPA3]の両方のセ
キュリティ認証を設定できます。デフォルトでは、[WPA2]チェックボックスが有効になってい
ます。[Personal]を選択した場合は、[Pass Phrase]フィールドにパスフレーズキーを入力します。
このキーは、クライアントと認証サーバーの間でペアワイズマスターキー（PMK）として使用
されます。

WPA3パーソナルは、パスワードベースの堅牢な認証を提供することによって、個人
ユーザーに対する保護を強化します。これにより、ブルートフォース辞書攻撃がは

るかに困難になり、時間がかかるようになります。

WPA2パーソナルの場合は、サイト、ビルディング、またはフロアレベルで、事前共
有キー（PSK）をオーバーライドできます。ビルディングレベルで PSKをオーバー
ライドすると、後続のフロアは新しい設定を継承します。詳細については、事前共

有キーのオーバーライド（27ページ）を参照してください。

2.4 GHzおよび 5 GHz帯域のみを使用するマルチバンド操作の場合、WPA2を有効に
する必要があります（WPA3はオプションです）。2.4 GHz、5 GHz、および 6 GHz
帯域を使用したマルチバンド動作の場合、Cisco IOS 17.7以降を搭載したデバイスで
6 GHz帯域を動作するには、WPA3を有効にしWPA2を無効にする必要があります。

（注）

（オプション）WPA2-Personalの場合、次の手順を実行してマルチ事前共有キー（MPSK）サポー
トを構成します。

1. [Configure MPSK]をクリックします。

2. [Configure MPSK]ダイアログボックスで、構成したいMPSKに対し [Add]をクリックしま
す。最大 5つのMPSKを追加できます。

3. [Priority]ドロップダウンリストから優先順位を選択します。

優先順位 0キーが中央Web認証（CWA）フレックスモードで設定されていない
場合、WLANへのクライアント接続が失敗する可能性があります。

（注）

4. [Passphrase Type]ドロップダウンリストから、パスフレーズタイプを選択します。

5. [Passphrase]フィールドに、パスフレーズを入力します。

6. [Save]をクリックします。

MPSKはCisco AireOSワイヤレスコントローラでサポートされていません。MPSKは、
WPA2-Personalの 2セキュリティ構成に適用されます。

• [Open Secured]：[Assign Open SSID]ドロップダウンリストから、クライアントをオープンでセ
キュアな SSIDにリダイレクトするためのオープン SSIDを選択します。オープンでセキュアな
ポリシーは、セキュリティが最も低くなります。

Fast Transitionは、オープンでセキュアな SSIDには適用できません。

オープンでセキュアなSSIDはオープンSSIDに依存しているため、オープンでセキュ
アな SSIDでアンカーを有効にする前に、オープン SSIDでアンカーを有効にしてお
く必要があります。

（注）
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• [Open]：オープンなポリシーはセキュリティを備えていません。すべてのデバイスが認証なしで
ワイヤレスネットワークに接続できます。

b) [Authentication, Authorization, and Accounting Configuration]で、[Configure AAA]をクリックして、エ
ンタープライズワイヤレスネットワーク SSID用の AAAサーバーを追加および設定します。

詳細については、エンタープライズワイヤレスネットワーク用の AAAサーバーの設定（29ペー
ジ）を参照してください。

c) [AAA Override]チェックボックスをオンにして、AAAオーバーライド機能を有効にします。

デフォルトでは、このチェックボックスはグレー表示されています。このチェックボックスを使用

するには、[Configure AAA]オプションを使用して AAAサーバを設定する必要があります。

d) 次のチェックボックスをオンにします（複数可）。

• [Fast Lane]：このネットワークで fastlane機能を有効にするには、このチェックボックスをオン
にします。

fastlaneを有効にすると、最適化されたレベルのワイヤレス接続と拡張QoSを受信す
るように Cisco IOSデバイスを設定できます。

（注）

• [Identity PSK]（個人レイヤ 2セキュリティ用）：SSID内の個人またはユーザーグループのため
に作成できる一意の事前共有キーを有効にするには、このチェックボックスをオンにします。

• [MAC Filtering]：ワイヤレスネットワークでのMACベースのアクセス制御またはセキュリティ
を有効にするには、このチェックボックスをオンにします。

MACフィルタリングを有効にすると、ワイヤレスLANに追加したMACアドレスに
のみWLANへの接続が許可されます。

（注）

• [Deny RCM Clients]：ランダム化されたMACアドレスを持つクライアントを拒否するには、こ
のチェックボックスをオンにします。

• [Enable Posture]：ポスチャ評価を有効にするには、このチェックボックスをオンにします。ポス
チャを有効にすると、[Pre-Auth ACL List Name]ドロップダウンリストが表示されます。ポスチャ
は、Cisco Identity Services Engine（ISE）のサービスです。ポスチャを使用すると、ネットワーク
に接続されているすべてのエンドポイントの企業セキュリティポリシーとのコンプライアンス

に関するステート（ポスチャとも呼ばれる）をチェックできます。これにより、ネットワーク

の防護領域にアクセスするクライアントを制御できます。

• [Pre-Auth ACL List Name]：ドロップダウンリストから、SSIDにマッピングするために作成した
ACLリスト名を選択します。

ポスチャには AAA設定が必須です。[Configure AAA]をクリックして、エンタープ
ライズワイヤレスネットワーク SSID用の AAAサーバーを追加します。

（注）

e) [Next]をクリックします。

ステップ 7 [Advance Settings]の設定を完了します。

a) [Fast Transition (802.11r)]で、次の手順を実行します。
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• [Adaptive]、[Enable]、または [Disable]モードを選択します。

802.11rを使用すると、ワイヤレスクライアントは、あるAPから別のAPにすばや
くローミングできます。Fast Transitionによって、ワイヤレスクライアントがAPか
ら別の APにローミングするときの接続の中断が軽減されます。

（注）

•分散システム経由の高速移行を有効にするには、[Over the DS]チェックボックスをオンにしま
す。

b) [MFP Client Protection]で、[Optional]、[Required]、または [Disabled]を選択します。

管理フレーム保護（MFP）により、管理フレームのセキュリティが強化されます。これ
によって、APとクライアントとの間で送受信される、保護および暗号化されていない
802.11管理メッセージのセキュリティが確保されます。MFPは、インフラストラクチャ
とクライアントサポートの両方を実現します。

デフォルトでは、[Optional]が選択されています。[Required]を選択すると、MFPがネ
ゴシエートされている場合（つまり、WPA2がワイヤレスコントローラ上で設定され
ており、クライアントもWPA2用に設定されていて、CCXv5 MFPをサポートしている
場合）にのみ、クライアントはアソシエーションを許可されます。

（注）

c) [Protected Management Frame (802.11w)]で、必要なオプションを選択します。

[Protected Management Frame (802.11w)]で使用できるオプションは、[Level of Security]
で選択した設定によって異なります。次のオプションを使用できる場合があります。

•オプション

•必須

• Disabled

（注）

d) [11K]で、次の設定を指定します。

• [Neighbor List]：このチェックボックスをオンにして、すべての11k対応クライアントが、ロー
ミングの候補となる既知のネイバーAPに関するネイバーレポートを要求できるように設定し
ます。

ローミングを容易に行うため、APにアソシエートした 11k対応クライアントは、
ネイバーAPのリストに対する要求を送信します。この要求は、アクションフレー
ムと呼ばれる 802.11管理フレームの形式で送信されます。APは、同じWLAN上
にあるネイバー APのWi-Fiチャネル番号が付いたリストを使用して応答します。
この応答もアクションフレームです。クライアントは応答フレームに基づき、次

のローミング先の AP候補を識別します。

（注）

• [Session Timeout]：クライアントセッションがアクティブである最大時間を設定するには、こ
のチェックボックスをオンにします。この時間が経過すると再認証を受ける必要があります。

デフォルトでは、[Session Timeout]が 1800秒のタイムアウト付きで有効になりま
す。

（注）
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• [Client Exclusion]：クライアント除外タイマーを設定するには、このチェックボックスをオン
にします。

ユーザーが認証に失敗すると、ワイヤレスコントローラはクライアントを接続か

ら除外します。除外タイマーが期限切れになるまで、クライアントはネットワーク

への接続を許可されません。デフォルトでは、[Client Exclusion]が 180秒のタイム
アウト付きで有効になります。

（注）

e) [11v BSS Transition Support]で、次の設定を指定します。

• [BSS Max Idle Service]：アイドル期間タイマー値を設定するには、このチェックボックスをオ
ンにします。アイドル期間タイマー値は、APからクライアントへのアソシエーションおよび
再アソシエーション応答フレームを使用して送信されます。

BSS最大アイドル期間は、接続先のクライアントからフレームが送信されないとい
う理由でAPがこのクライアントをアソシエート解除しないタイムフレームのこと
です。

（注）

• [Client User Idle Timeout]：WLANのユーザーアイドルタイムアウトを設定するには、この
チェックボックスをオンにします。

クライアントが送信するデータがユーザーアイドルタイムアウトとして指定され

たしきい値のクォータを超える場合、クライアントはアクティブであると見なさ

れ、ワイヤレスコントローラは別のタイムアウト期間を開始します。

デフォルトでは、[Client User Idle Timeout]が 300秒のユーザーアイドルタイムア
ウト付きで有効になっています。

（注）

• [Directed Multicast Service]：Directed Multicast Serviceを有効にするには、このチェックボック
スをオンにします。

デフォルトでは、[Directed Multicast Service]が有効になっています。クライアント
は Directed Multicast Service（DMS）を使用して、必要なマルチキャストパケット
をユニキャストフレームとして送信するようにAPに要求します。これにより、ク
ライアントは長時間スリープ状態になり、バッテリの電力が節約されます。

（注）

f) [Radius Client Profiling]で、このトグルボタンを使用してWLANでの RADIUSプロファイリングを
有効または無効にします。

この機能を有効にするには、1つ以上の AAAまたは PSNサーバーが必要です。（注）

g) （オプション）[NAS-ID]で、次の設定を指定します。

1. [NAS-ID Opt]ドロップダウンリストから、必要なタイプのネットワークアクセスサーバー識
別子（NAS ID）を選択します。

NASIDのカスタムスクリプトを指定するには、[NAS-IDOpt]ドロップダウンリストから [Custom
Option]を選択し、対応する [Custom Script for Opt]フィールドにカスタムスクリプトを入力し
ます。カスタムスクリプトには、最大 31文字の英数字、特殊文字、およびスペースを入力で
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きます。Cisco DNA Centerはカスタムスクリプトでの特殊文字 ? " <および末尾のスペースを
サポートしていません。

Cisco DNA Centerは、Cisco IOS XEリリース 17.7以降を実行するCisco Catalyst 9800
シリーズワイヤレスコントローラに対してのみ、カスタムスクリプトで NAS ID
をサポートします。

（注）

2. （オプション）[+]をクリックして、別のNAS IDを追加します。最大 3つのNAS IDを追加で
きます。

Cisco DNA Centerは Cisco AireOSワイヤレスコントローラの 1つの NAS IDのみ適
用します。[Design] > [Network Settings] > [Wireless]ウィンドウからサイトレベル
で NAS IDを上書きできます。

（注）

h) [Configure CCKM]：このトグルボタンを使用して、Cisco DNA Centerで認証キー管理オプションと
して CCKMを有効にします。

• [Timestamp Tolerance]：このフィールドは、CCKMを有効にしている場合にのみ表示されま
す。CCKM許容レベルを入力します。CCKM許容レベルは、Cisco AireOSワイヤレスコント
ローラプラットフォームには適用されません。

SSIDにWPA2またはWPA2+WPA3のエンタープライズとしてレイヤ 2セキュリティ
がある場合にのみ、CCKMを設定できます。

（注）

i) （任意） [Configure Client Rate Limit]で、クライアントレート制限の値をビット/秒で入力します。
有効な範囲は 8000～ 100000000000です。値は 500の倍数である必要があります。

この構成はCisco AireOSワイヤレスコントローラには適用できません。Cisco AireOSワ
イヤレスコントローラのクライアントレート制限を設定するには、メニューアイコン

（ ）をクリックして、 [Tools] > [Model Config Editor] > [Wireless] > [Advanced SSID
Configuration]を選択します。詳細については、高度なSSIDのモデル設定設計の作成を
参照してください。

（注）

Cisco IOS XEデバイスのクライアントレート制限の有効範囲は次のとおりです。

• Cisco Catalyst 9800-Lワイヤレスコントローラ、Cisco Catalyst 9800-40ワイヤレスコントロー
ラ、およびCisco Catalyst 9800-80ワイヤレスコントローラの有効範囲は、8000～ 67000000000
ビット/秒です。

• Cisco Catalyst 9800-CLワイヤレスコントローラの有効範囲は、8000～ 10000000000ビット/秒
です。

• Catalystアクセスポイント上のシスコ組み込みワイヤレスコントローラの有効範囲は、8000～
2000000000ビット/秒です。

• Catalyst 9000シリーズスイッチ用 Cisco Catalyst 9800組み込みワイヤレスコントローラの有効
範囲は、8000～ 100000000000ビット/秒です。
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j) （任意） [Coverage Hole Detection]トグルボタンを使用して、カバレッジホールの検出機能を有効
または無効にします。

k) [Next]をクリックします。

ステップ 8 [Associate SSID to Profile]の手順を完了します。

a) 左側のペインからプロファイルを選択し、[Associate Profile]をクリックします。

プロファイルがない場合は、[Add Profile]をクリックして、プロファイル設定を指定します。詳細に
ついては、エンタープライズワイヤレスネットワーク用 SSIDの作成（20ページ）を参照してくだ
さい。

b) [Next]をクリックします。

ステップ 9 [Summary]ウィンドウで、設定を確認します。変更するには、[Edit]をクリックします。

ステップ 10 [保存 (Save)]をクリックします。

SSIDが作成されます。

事前共有キーのオーバーライド

SSIDはグローバル階層に作成されます。サイト、ビルディング、およびフロアは、グローバ
ル階層から設定を継承します。サイト、ビルディング、またはフロアレベルで、事前共有キー

（PSK）をオーバーライドできます。ビルディングレベルでPSKをオーバーライドすると、後
続のフロアは新しい設定を継承します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Wireless]の順に選択します。

ステップ 2 左側の階層ツリーから、PSKを編集するサイト、ビルディング、またはフロアを選択します。

ステップ 3 [Enterprise Wireless]の下の [Passphrase]フィールドをクリックし、PSK SSIDの新しいパスフレーズを入力
します。

ステップ 4 [保存（Save）]をクリックします。

「Passphrase for the SSID(s) updated successfully」という成功メッセージが表示されま
す。

SSIDの横にある検証アイコン にカーソルを合わせると、この設定の継承元が表示されます。

ステップ 5 PSKオーバーライドをリセットするには、サイト、ビルディング、またはフロアの PSK SSIDのチェック
ボックスをオンにして、[削除 (Delete)]をクリックします。PSKはグローバルパスフレーズ値にリセットさ
れます。

認証前アクセスコントロールリストの作成

認証前ACL機能を使用すると、Web認証用の認証前ACLを作成して、認証が完了する前に特
定のタイプのトラフィックを許可できます。このACLは、Cisco Identity Services Engine（ISE）
の access-acceptで参照され、ACLによって許可されるトラフィックと拒否されるトラフィック
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を定義します。シスコワイヤレスコントローラで設定したACLは、管理インターフェイス、
APマネージャインターフェイス、任意の動的インターフェイス、またはWLANに適用されて
ワイヤレスクライアントとの間の双方向のデータトラフィックを制御します。または、コント

ローラの中央処理装置（CPU）に適用してCPU宛のすべてのトラフィックを制御します。IPv4
と IPv6の両方の ACLを設定できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Pre-Auth Access Control Lists]エリアで、[Add]をクリックして新しい認証前 ACLを作成します。

ステップ 5 [New Pre-Auth ACL]スライドインペインで、次のように設定します。

1. [Pre-Auth ACL List Name]フィールドに、ACLリストの名前を入力します。

2. [Pre-Auth ACL Name]フィールドに、認証前 ACLの名前を入力します。

3. [IP Addresses]タブをクリックし、作成する ACLタイプ（[IPV4]または [IPV6]）を選択します。

ステップ 6 [IP Addresses]タブをクリックし、作成する ACLタイプ（[IPV4]または [IPV6]）を選択します。

1. [Protocol]ドロップダウンリストから、この ACLに使用する IPパケットのプロトコル IDを選択し
ます。プロトコルオプションは、[Any]、[TCP]、または [UDP]です。

2. [Source Port]フィールドに、送信元ポート番号を入力します。指定できる範囲は 0～ 65535です。
ポートオプションは、ネットワーキングスタックとのデータ送受信をするアプリケーションによっ

て使用されます。一部のポートは、Telnet、SSH、HTTPなど特定のアプリケーション用に指定され
ています。

3. [Source IP Address]フィールドに、送信元の IPアドレスとネットマスクを入力します。IPv6 ACLを
設定している場合は、[Source IP Address]フィールドに送信元の IPv6アドレスとプレフィックスの長
さを入力します。

4. [Source Subnet]ドロップダウンリストから、送信元サブネットの値を選択します。

5. [Destination Port]に宛先ポート番号を入力します。

6. [Destination IP Address]に、宛先の IPアドレスおよびネットマスクを入力します。IPv6 ACLを設定
している場合は、宛先の IPv6アドレスとプレフィックス長を入力します。

7. [Destination Subnet]ドロップダウンリストから、宛先サブネットの値を選択します。

8. 複数のルールを追加するには、 アイコンをクリックします。最大256個のルールを追加できます。

ステップ 7 [Walled Garden URLs]タブをクリックして、キャプティブポータルとウォールドガーデンのWeb認証の
許可リストに特定のURLを追加します。URLの許可リストにアクセスする際に認証は必要ありません。
許可リストに含まれていないサイトにアクセスしようとすると、ログインページにリダイレクトされま

す。
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ステップ 8 [URL]フィールドに URLを入力し、 をクリックしてWeb認証の許可リストに URLを追加します。最
大 32個の URLエントリを追加できます。

ステップ 9 [Save]をクリックします。

ステップ 10 エンタープライズワイヤレスネットワークの SSIDを作成するときに、ACLを SSIDにマッピングしま
す。

エンタープライズワイヤレスネットワーク用の AAAサーバーの設定

始める前に

• [System Settings] > [External Services] > [Authentication and Policy Servers]で、AAAサー
バーが定義されていることを確認してください。

•この手順を実行するには、管理者（ROLE_ADMIN）またはポリシー管理者
（ROLE_POLICY_ADMIN）権限、および適切な RBACスコープが必要です。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [SSID]テーブルの [Action]列で、AAAサーバーを設定する SSIDに対して [Configure AAA]をクリックし
ます。

ステップ 5 [Configure AAA Server]スライドインペインの [Configure Authentication and Authorization Server]ドロップ
ダウンリストから、[Search]フィールドに名前を入力してサーバーの IPアドレスを検索するか、AAA IP
アドレスを選択します。

[Configure AAA]オプションは、Mobility Express（ME）デバイスではサポートされていませ
ん。

（注）

ステップ 6 [+]をクリックして、[Additional Server]を追加します。

Catalyst 9000シリーズスイッチ用 Cisco Catalyst 9800組み込みワイヤレスコントローラのエン
タープライズワイヤレスネットワークの SSIDには、最大 6つの AAAサーバーを設定でき
ます。

（注）

ステップ 7 [Additional Server]ドロップダウンリストから、サーバーの IPアドレスを選択します。

ステップ 8 アカウンティングに AAAサーバーを使用するには、[Copy Same Servers for Accounting]チェックボック
スをオンにします。

ステップ 9 SSIDに別のアカウンティングサーバーを設定するには、次の手順を実行します。

a) [Configure Accounting Server]ドロップダウンリストから、[Search]フィールドに名前を入力してサー
バーの IPアドレスを検索するか、アカウンティングサーバーの IPアドレスを選択します。

b) [+]をクリックして、[Additional Server]を追加します。
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Catalyst 9000シリーズスイッチ用 Cisco Catalyst 9800組み込みワイヤレスコントローラの
エンタープライズワイヤレスネットワークの SSIDには、最大 6つのアカウンティング
サーバーを設定できます。

（注）

c) [Additional Server]ドロップダウンリストから、サーバーの IPアドレスを選択します。

ステップ 10 [構成]をクリックします。

Cisco DNA Centerでは、サイトレベルで SSIDの一連の AAAサーバー設定をオーバーライド
できます。SSIDごとにオーバーライドされた一連の AAA設定ごとに、対応する AAAサー
バーがマッピングされた新しいWLANプロファイルがCisco DNA Centerによって作成されま
す。異なるフロアの SSIDがオーバーライドされ、AAAサーバーで変更を行うと、フロア数
に等しい数の新しいWLANプロファイルが Cisco DNA Centerによって作成されます。

サイトレベルでAAAサーバーをオーバーライドするためには、デバイスを再プロビジョニン
グする必要があります。ワイヤレスデバイスプロビジョニングの概要を参照してください。

（注）

ゲストワイヤレスネットワークの SSIDの作成
この手順では、ゲストワイヤレスネットワークのSSIDを作成する方法について説明します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [SSID]テーブルで、[Add]の上にカーソルを合わせて、[Guest]を選択します。

ステップ 5 [Wireless SSID]ワークフローで、[Basic Settings]のセットアップを完了します。

a) [Wireless Network Name (SSID)]フィールドに、ワイヤレスネットワークの一意の名前を入力します。
b) [WLAN Profile Name]フィールドに、WLANプロファイルの名前を入力します。

Cisco DNA CenterはWLANプロファイル名に基づいて、Cisco Catalyst 9800シリーズワイヤレスコ
ントローラのポリシープロファイル名を自動的に生成します。

c) [Wireless Option]の設定で、次のいずれかのオプションボタンをクリックします。

• [Multi band operation（2.4 GHz, 5 GHz, 6GHz）]：WLANは 2.4 GHz、5 GHz、および 6 GHz用に
作成され、バンドセレクトは無効になっています。

• [Multi band operation with band select]：WLANは 2.4 GHz、5 GHz、および 6 GHz用に作成され、
バンドセレクトは有効になっています。

• [5 GHz only]：WLANが 5 GHz用に作成され、バンドセレクトは無効になっています。

• [2.4 GHz only]：WLANが 2.4 GHz用に作成され、バンドセレクトは無効になっています。

• [6GHz Only]：WLANは 6 GHz用に作成され、バンドセレクトは無効になっています。

ネットワークの設定

30

ネットワークの設定

ゲストワイヤレスネットワークの SSIDの作成

b_cisco_dna_center_ug_2_3_5_chapter17.pdf#nameddest=unique_262


d) [Primary Traffic Type]ドロップダウンリストから、次のいずれかのオプションを選択します。

• [VoIP (Platinum)]：ワイヤレスネットワークの QoSは、ワイヤレス音声およびデータトラフィッ
ク用に最適化されています。

• [Video (Gold)]：ワイヤレスネットワークのQoSはビデオトラフィック用に最適化されています。

• [Best Effort (Silver)]：ワイヤレスネットワークの QoSは、ワイヤレスデータトラフィック用に
のみ最適化されています。

• [Non-real Time (Bronze)]：ワイヤレスネットワークのQoSは、低帯域幅の使用に最適化されてい
ます。

e) [SSID STATE]設定では、トグルボタンをクリックして、次の設定を有効または無効にします。

• [Admin Status]：このトグルボタンを使用して、APの無線をオンまたはオフにします。[Admin
Status]が無効になっている場合、APはワイヤレスコントローラに関連付けられたままで、ア
クセス可能であり、APには引き続きライセンスが必要です。

• [Broadcast SSID]：範囲内のすべてのワイヤレスクライアントに対してSSIDの可視性を有効また
は無効にするには、このトグルボタンを使用します。

ステップ 6 [Security Settings]の設定を完了します。

a) [L2 Security]設定で、L2暗号化および認証タイプを選択します。

• [Enterprise]：[WPA2]または [WPA3]のいずれかのセキュリティ認証タイプを設定するには、そ
れぞれのチェックボックスをオンにします。デフォルトでは、[WPA2]チェックボックスが有効
になっています。

Wi-Fi Protected Access（WPA2）では、Counter Modeと暗号ブロック連鎖メッセージ
認証コードプロトコルを使用した、より強力な高度暗号化規格アルゴリズム

（AES-CCMP）が使用されます。Fast transitionは、エンタープライズWPA2 SSIDに
適用できます。

WPA3セキュリティ認証は、WPAの最新バージョンです。これは、Wi-Fiネットワー
クの認証と暗号化を提供するプロトコルとテクノロジーのスイートです。WPA3エン
タープライズは、センシティブデータネットワーク用に、より高いグレードのセ

キュリティプロトコルを提供します。

2.4 GHzおよび 5 GHz帯域のみを使用するマルチバンド操作の場合、WPA2を有効に
する必要があります（WPA3はオプションです）。2.4 GHz、5 GHz、および 6 GHz
帯域を使用したマルチバンド動作の場合、Cisco IOS 17.7以降を搭載したデバイスで
6 GHz帯域を動作するには、WPA3を有効にしWPA2を無効にする必要があります。

（注）

• [Personal]：WPA2とWPA3の両方を設定したり、WPA2とWPA3を個別に設定したりするに
は、それぞれのチェックボックスをオンにします。
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WPA3パーソナルセキュリティ認証は、パスワードベースの堅牢な認証を提供するこ
とによって個人ユーザーに対する保護を強化します。これにより、ブルートフォー

ス辞書攻撃がはるかに困難になり、時間がかかるようになります。

[Pass Phrase]フィールドにパスフレーズキーを入力します。このキーは、クライアン
トと認証サーバーの間で Pairwise Master Key（PMK;ペアワイズマスターキー）とし
て使用されます。

2.4 GHzおよび 5 GHz帯域のみを使用するマルチバンド操作の場合、WPA2を有効に
する必要があります（WPA3はオプションです）。2.4 GHz、5 GHz、および 6 GHz
帯域を使用したマルチバンド動作の場合、Cisco IOS 17.7以降を搭載したデバイスで
6 GHz帯域を動作するには、WPA3を有効にしWPA2を無効にする必要があります。

（注）

（オプション）WPA2-Personalの場合、次の手順を実行してマルチ事前共有キー（MPSK）サポー
トを構成します。

1. [Configure MPSK]をクリックします。

2. [Configure MPSK]ダイアログボックスで、構成したいMPSKに対し [Add]をクリックしま
す。最大 5つのMPSKを追加できます。

3. [Priority]ドロップダウンリストから優先順位を選択します。

優先順位 0キーが中央Web認証（CWA）フレックスモードで設定されていない
場合、WLANへのクライアント接続が失敗する可能性があります。

（注）

4. [Passphrase Type]ドロップダウンリストから、パスフレーズタイプを選択します。

5. [Passphrase]フィールドに、パスフレーズを入力します。

6. [Save]をクリックします。

MPSKはCisco AireOSワイヤレスコントローラでサポートされていません。MPSKは、
WPA2-Personalの 2セキュリティ構成に適用されます。

• [Open Secured]：[Assign Open SSID]ドロップダウンリストから、オープン SSIDに関連付けるた
めのオープン SSIDを選択します。関連付けにより、オープン SSIDが保護されます。オープン
でセキュアな SSIDに関連付ける前に、オープン SSIDが作成されている必要があります。

Fast Transitionは、オープンでセキュアな SSIDには適用できません。

オープンでセキュアなSSIDはオープンSSIDに依存しているため、オープンでセキュ
アな SSIDでアンカーを有効にする前に、オープン SSIDでアンカーを有効にしてお
く必要があります。

（注）

• [Open]：オープンなポリシーはセキュリティを備えていません。すべてのデバイスが認証なしで
ワイヤレスネットワークに接続できます。

b) [L3 Security]設定で、L3暗号化および認証タイプを選択します。

• [Web Policy]：L3セキュリティを強化します。
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[Authentication Server]で、これらの認証サーバー設定を指定します。

説明認証サーバタイプ

中央Web認証（CWA）に AAAサーバーを使用します。

（オプション）CWAに Cisco ISEを選択した場合は、[What
kind of portal are you creating today?]ドロップダウンリストで、
作成するポータルのタイプを選択します。

• [Self Registered]：ゲストは自己登録ゲストポータルにリ
ダイレクトされ、情報を提供して登録して、自動的にア

カウントを作成します。

• [HotSpot]：ゲストはログイン情報なしでネットワークに
アクセスできます。

（オプション）CWAに Cisco ISEを選択した場合は、[Where
will your guests redirect after successful authentication?]ドロップ
ダウンリストで、認証が成功した後にゲストをリダイレクト

する場所を選択します。

• [Success page]：ゲストは［Authentication Success］ウィン
ドウにリダイレクトされます。

• [Original URL]：ゲストは最初にリクエストした URLに
リダイレクトされます。

• [CustomURL]：ゲストはここで特定されたカスタムURL
にリダイレクトされます。[Redirect URL]フィールドに
リダイレクト URLを入力します。

Central Web Authentication（中
央Web認証）

レイヤ 3セキュリティ方式であるWeb認証（Web Auth）を
使用すると、クライアントは、何らかの認証方式に合格する

までの間、Dynamic Host Configuration Protocol（DHCP）およ
びドメインネームシステム（DNS）のトラフィックを通過さ
せることができます。

Web認証（内部）の場合、クライアントはシスコワイヤレ
スコントローラによって作成されたページにリダイレクトさ

れます。

Web認証（外部）の場合は、クライアントが、指定された
URLにリダイレクトされます。[Web Auth Url]フィールドに
リダイレクト URLを入力します。

• Web認証（内部）

• Web認証（外部）
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説明認証サーバタイプ

Webパススルーは、ゲストアクセスに使用されるソリュー
ションであり、認証ログイン情報は必要ありません。Webパ
ススルー認証では、ワイヤレスユーザーがインターネットを

初めて使用するとき、使用ポリシーページにリダイレクトさ

れます。ポリシーを承認すると、ユーザーはインターネット

を使用できます。

• Webパススルー（内部）

• Webパススルー（外部）

• [Open]：レイヤ 3レベルのセキュリティがなく、どのデバイスも SSIDに接続できます。

c) [Web Authentication Internal]、[Web Authentication External]、[Web Passthrough Internal]、または [Web
Passthrough External]を選択した場合、[Timeout Settings for sleeping clients]の設定で、スリープしてい
るクライアントの認証を選択します。

• [Always authenticate]：スリープ状態のクライアントの認証が有効になります。

• [Authenticate after]：再認証が必要になるまでスリープ状態にあるクライアントが記憶される期間
を入力します。有効範囲は 10～ 43200分、デフォルト期間は 720分です。

ゲストアクセスでWeb認証済みクライアントは、ログインページから別の認証プロセス
を実行せずにスリープおよび復帰することを許可されています。再認証が必要になるま

でスリープ状態にあるクライアントが記録される期間を設定できます。有効な範囲は 10
～ 43200分、デフォルトは 720分です。WLANにマッピングされるユーザグループポリ
シーとWLANに、期間を設定できます。スリープタイマーは、アイドルタイムアウト
後に有効になります。クライアントタイムアウトがWLANのスリープタイマーに設定さ
れた時間より短い場合は、クライアントのライフタイムがスリープ時間として使用され

ます。

（注）

d) [Authentication, Authorization, and Accounting Configuration]で、[Configure AAA]をクリックして、ゲ
ストワイヤレスネットワーク SSID用の AAAサーバーを追加および設定します。

詳細については、ゲストワイヤレスネットワーク用のAAAサーバーの設定（39ページ）を参照し
てください。

e) [AAA Override]チェックボックスをオンにして、AAAオーバーライド機能を有効にします。

デフォルトでは、このチェックボックスはグレー表示されています。このチェックボックスを使用

するには、[Configure AAA]オプションを使用して AAAサーバを設定する必要があります。

f) 次のチェックボックスをオンにします（複数可）。

• [Fast Lane]：このネットワークで fastlane機能を有効にするには、このチェックボックスをオン
にします。

fastlaneを有効にすると、最適化されたレベルのワイヤレス接続と拡張QoSを受信す
るように Cisco IOSデバイスを設定できます。

（注）

• [Identity PSK]（個人L2セキュリティ用）：SSID内の個人またはユーザーグループのために作成
できる一意の事前共有キーを有効にするには、このチェックボックスをオンにします。
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• [MAC Filtering]：ワイヤレスネットワークでのMACベースのアクセス制御またはセキュリティ
を有効にするには、このチェックボックスをオンにします。

MACフィルタリングを有効にすると、ワイヤレスLANに追加したMACアドレスに
のみWLANへの接続が許可されます。

（注）

• [Deny RCM Clients]：ランダム化されたMACアドレスを持つクライアントを拒否するには、こ
のチェックボックスをオンにします。

g) [Next]をクリックします。

ステップ 7 [Advance Settings]の設定を完了します。

a) [Fast Transition (802.11r)]で、次の手順を実行します。

• [Adaptive]、[Enable]、または [Disable]モードを選択します。

802.11rを使用すると、ワイヤレスクライアントは、あるAPから別のAPにすばやく
ローミングできます。Fast Transitionによって、ワイヤレスクライアントが APから
別の APにローミングするときの接続の中断が軽減されます。

（注）

•分散システム経由の高速移行を有効にするには、[Over the DS]チェックボックスをオンにしま
す。

b) [MFP Client Protection]で、[Optional]、[Required]、または [Disabled]を選択します。

管理フレーム保護（MFP）により、管理フレームのセキュリティが強化されます。これ
によって、APとクライアントとの間で送受信される、保護および暗号化されていない
802.11管理メッセージのセキュリティが確保されます。MFPは、インフラストラクチャ
とクライアントサポートの両方を実現します。

デフォルトでは、[Optional]が選択されています。[Required]を選択すると、MFPがネゴ
シエートされている場合（つまり、WPA2がワイヤレスコントローラ上で設定されてお
り、クライアントもWPA2用に設定されていて、CCXv5 MFPをサポートしている場合）
にのみ、クライアントはアソシエーションを許可されます。

（注）

c) [Protected Management Frame (802.11w)]で、必要なオプションを選択します。

[Protected Management Frame (802.11w)]で使用できるオプションは、[Level of Security]で
選択した設定によって異なります。次のオプションを使用できる場合があります。

•オプション

•必須

• Disabled

（注）

d) [11K]で、次の設定を指定します。

• [Neighbor List]：このチェックボックスをオンにすると、すべての11k対応クライアントが、ロー
ミングの候補となる既知のネイバー APに関するネイバーレポートを要求できるようになりま
す。

ネットワークの設定

35

ネットワークの設定

ゲストワイヤレスネットワークの SSIDの作成



ローミングを容易に行うため、APにアソシエートした 11k対応クライアントは、ネ
イバーAPのリストに対する要求を送信します。この要求は、アクションフレームと
呼ばれる 802.11管理フレームの形式で送信されます。APは、同じWLAN上にある
ネイバーAPのWi-Fiチャネル番号が付いたリストを使用して応答します。この応答
もアクションフレームです。クライアントは応答フレームに基づき、次のローミン

グ先の AP候補を識別します。

（注）

• [Session Timeout]：クライアントセッションがアクティブである最大時間を設定するには、この
チェックボックスをオンにします。この時間が経過すると再認証を受ける必要があります。

デフォルトでは、[Session Timeout]が 1800秒のタイムアウト付きで有効になります。（注）

• [Client Exclusion]：クライアント除外タイマーを設定するには、このチェックボックスをオンに
します。

ユーザーが認証に失敗すると、ワイヤレスコントローラはクライアントを接続から

除外します。除外タイマーが期限切れになるまで、クライアントはネットワークへ

の接続を許可されません。デフォルトでは、[Client Exclusion]が 180秒のタイムアウ
ト付きで有効になります。

（注）

e) [11v BSS Transition Support]で、次の設定を指定します。

• [BSS Max Idle Service]：アイドル期間タイマー値を設定するには、このチェックボックスをオン
にします。アイドル期間タイマー値は、APからクライアントへのアソシエーションおよび再ア
ソシエーション応答フレームを使用して送信されます。

BSS最大アイドル期間は、接続先のクライアントからフレームが送信されないとい
う理由でAPがこのクライアントをアソシエート解除しないタイムフレームのことで
す。

（注）

• [Client User Idle Timeout]：WLANのユーザーアイドルタイムアウト期間を設定するには、この
チェックボックスをオンにします。

クライアントが送信するデータがユーザーアイドルタイムアウト期間として指定さ

れたしきい値のクォータを超える場合、クライアントはアクティブであると見なさ

れ、ワイヤレスコントローラは別のタイムアウト期間を開始します。

デフォルトでは、[Client User Idle Timeout]が 300秒のユーザーアイドルタイムアウ
ト付きで有効になっています。

（注）

• [Directed Multicast Service]：Directed Multicast Serviceを有効にするには、このチェックボックス
をオンにします。

デフォルトでは、[Directed Multicast Service]が有効になっています。クライアントは
Directed Multicast Service（DMS）を使用して、必要なマルチキャストパケットをユニ
キャストフレームとして送信するようにAPに要求します。これにより、クライアン
トは長時間スリープ状態になり、バッテリの電力が節約されます。

（注）
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f) （オプション）[NAS-ID]で、次の設定を指定します。

1. [NAS-ID Opt]ドロップダウンリストから、必要なタイプのネットワークアクセスサーバー識別
子（NAS ID）を選択します。

（オプション）NAS IDのカスタムスクリプトを指定するには、[NAS-ID Opt]ドロップダウンリ
ストから [Custom Option]を選択し、対応する [Custom Script for Opt]フィールドにカスタムスク
リプトを入力します。カスタムスクリプトには、最大31文字の英数字、特殊文字、およびスペー
スを入力できます。Cisco DNA Centerはカスタムスクリプトでの特殊文字 ? " <および末尾のス
ペースをサポートしていません。

Cisco DNA Centerは、Cisco IOS XEリリース 17.7以降を実行する Cisco Catalyst 9800
シリーズワイヤレスコントローラに対してのみ、カスタムスクリプトで NAS IDを
サポートします。

（注）

2. （オプション）[+]をクリックして、別のネットワークアクセスサーバー識別子を追加します。
最大 3つの NAS IDを追加できます。

Cisco DNA Centerでは Cisco AireOSコントローラに 1つの NAS IDのみを適用しま
す。[Design] > [Network Settings] > [Wireless]ウィンドウからサイトレベルで NAS ID
を上書きできます。

（注）

g) （任意） [Configure Client Rate Limit]で、クライアントレート制限の値をビット/秒で入力します。
有効な範囲は 8000～ 100000000000です。値は 500の倍数である必要があります。

この構成はCisco AireOSワイヤレスコントローラには適用できません。Cisco AireOSワイ
ヤレスコントローラのクライアントレート制限を設定するには、メニューアイコン（ ）

をクリックして、 [Tools] > [Model Config Editor] > [Wireless] > [Advanced SSID
Configuration]を選択します。詳細については、高度な SSIDのモデル設定設計の作成を
参照してください。

（注）

Cisco IOS XEデバイスのクライアントレート制限の有効範囲は次のとおりです。

• Cisco Catalyst 9800-Lワイヤレスコントローラ、Cisco Catalyst 9800-40ワイヤレスコントローラ、
および Cisco Catalyst 9800-80ワイヤレスコントローラの有効範囲は、8000～ 67000000000ビッ
ト/秒です。

• Cisco Catalyst 9800-CLワイヤレスコントローラの有効範囲は、8000～ 10000000000ビット/秒で
す。

• Catalystアクセスポイント上のシスコ組み込みワイヤレスコントローラの有効範囲は、8000～
2000000000ビット/秒です。

• Catalyst 9000シリーズスイッチ用 Cisco Catalyst 9800組み込みワイヤレスコントローラの有効範
囲は、8000～ 100000000000ビット/秒です。

h) （任意） [Coverage Hole Detection]トグルボタンを使用して、カバレッジホールの検出機能を有効ま
たは無効にします。

i) [Next]をクリックします。
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ステップ 8 [Associate SSID to Profile]の手順を完了します。

a) 左側のペインで、プロファイルをクリックします。

b) プロファイルがない場合は、[Add Profile]をクリックして、プロファイル設定を指定します。

• [Profile Name]：ワイヤレスプロファイルの名前を入力します。

•（オプション）[WLAN Profile Name]：WLANプロファイルの名前を入力します。

Cisco DNA CenterはWLANプロファイル名に基づいて、Cisco Catalyst 9800シリーズワイヤレス
コントローラのポリシープロファイル名を自動的に生成します。

SSIDがネットワークプロファイルに関連付けられている場合、Cisco DNA Centerが
プロビジョニング中にこのWLANプロファイル名を使用します。SSIDを複数のネッ
トワークプロファイルに関連付ける必要がある場合は、プロビジョニングの失敗を

防ぐために、すべてのネットワークプロファイルで SSIDに対して一意のWLANプ
ロファイル名を入力することをお勧めします。

（注）

• [Fabric]：SSIDがファブリックか非ファブリックかを指定します。

ファブリック SSIDは、ソフトウェア定義型アクセス（SD-Access）の一部であるワ
イヤレスネットワークです。SDアクセスは、有線およびワイヤレスネットワークの
設定、ポリシー、およびトラブルシューティングを自動化し、簡素化するソリュー

ションです。ファブリックSSIDを使用する場合は、SDアクセスが必須です。非ファ
ブリックは、SDアクセスを必要としない従来のワイヤレスネットワークです。

（注）

非ファブリック SSIDの場合は、次の設定を選択します。

• [Interface]：[Interface Management]ドロップダウンリストからインターフェイスを選択する

か、プラスアイコン をクリックして新しいワイヤレスインターフェイスを追加します。

これは、ワイヤレスインターフェイスに関連付けられている VLAN IDです。（注）

• [VLAN Group]：[VLAN Group Name]ドロップダウンリストから VLANグループを選択する

か、プラスアイコン をクリックして VLANグループを追加します。

• [Do you need Anchor for this SSID?]：SSIDをアンカーにするかどうかを選択します。

[Yes]を選択した場合は、[Select Anchor Group]ドロップダウンリストから、SSIDのアンカーグ
ループを選択します。アンカーグループの詳細については、「アンカーグループの作成（71
ページ）」を参照してください。

• [Flex Connect Local Switching]：WLANのローカルスイッチングを有効にするには、チェックボッ
クスをオンにします。ローカルスイッチングを有効化すると、このWLANをアドバタイズする
すべての FlexConnect APがデータパケットをローカルにスイッチできます。

SSIDに関して [Flex Connect Local Switching]を有効にしている場合、ネットワークプ
ロファイルがマッピングされている特定のフロア上のすべてのAPがFlexConnectモー
ドに切り替わります。

（注）
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c) [Associate Profile]をクリックして、プロファイルを選択します。
d) [Next]をクリックします。

ステップ 9 [Summary]ウィンドウで、設定を確認します。変更するには、[Edit]をクリックします。

ステップ 10 SSIDの設定を保存するには、[Save]をクリックします。

SSIDが作成されます。

ゲストワイヤレスネットワーク用の AAAサーバーの設定

始める前に

• [System Settings] > [External Services] > [Authentication and Policy Servers]ウィンドウで、
AAAサーバーが定義されていることを確認してください。

•この手順を実行するには、管理者（ROLE_ADMIN）またはポリシー管理者
（ROLE_POLICY_ADMIN）権限、および適切な RBACスコープが必要です。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [SSID]テーブルの [Action]列で、AAAサーバーを設定する SSIDの [Configure AAA]をクリックします。

ステップ 5 [Configure AAA Server]スライドインペインの [Server]ドロップダウンリストから、[Search]フィールドに名
前を入力して AAA IPアドレスを検索するか、AAA IPアドレスを選択します。

•ゲストワイヤレスネットワークの中央Web認証（CWA）SSID用に少なくとも 1つのAAA
またはポリシーサービスノード（PSN）サーバーを設定する必要があります。

• Cisco DNA Centerでは、アイデンティティサービスエンジンのPSNとサードパーティAAA
IPの任意の組み合わせで AAAサーバーをマッピングできます。

• [Server]ドロップダウンリストで、AAA IPアドレスと PSN IPアドレスが対応するセクショ
ンにおいてグループ化されています。

• [Configure AAA]オプションは、Mobility Express（ME）デバイスではサポートされていま
せん。

（注）

ステップ 6 [+]をクリックして、[Additional Server]を追加します。

Catalyst 9000シリーズスイッチ用Cisco Catalyst 9800組み込みワイヤレスコントローラのゲスト
ワイヤレスネットワークの SSIDには、最大 6つの AAAサーバーを設定できます。

（注）

ステップ 7 [Additional Server]ドロップダウンリストから、サーバーの IPアドレスを選択します。
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ステップ 8 （任意）サーバーまたは追加のサーバーを削除するには、各サーバーの横にある削除アイコンをクリック
します。

ステップ 9 [構成]をクリックします。

Cisco DNA Centerでは、サイトレベルで SSIDの一連の AAAサーバー設定をオーバーライドで
きます。SSIDごとにオーバーライドされた一連の AAA設定ごとに、対応する AAAサーバー
がマッピングされた新しいWLANプロファイルがCisco DNA Centerによって作成されます。異
なるフロアの SSIDがオーバーライドされ、AAAサーバーで変更を行うと、フロア数に等しい
数の新しいWLANプロファイルが Cisco DNA Centerによって作成されます。

サイトレベルで AAAサーバーをオーバーライドするためには、デバイスを再プロビジョニン
グする必要があります。ワイヤレスデバイスプロビジョニングの概要を参照してください。

（注）

[SSID Scheduler]の作成
SSIDスケジューラで、タイムゾーンに基づいたWLANの切り替えを設定できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 [SSID]テーブルで、[SSID Scheduler]をクリックします。

ステップ 4 [SSID Scheduler]ウィンドウで、[Add]をクリックします。

ステップ 5 [Create Scheduler]スライドインペインで、次の手順を実行します。

a) 作成する SSIDスケジューラの一意の名前を入力します。
b) クライアントが SSIDに参加することを拒否するには、[Client Deny]オプションボタンをクリックしま
す。

c) [Enable SSID]をクリックして、SSIDブロードキャストをスケジュールします。
d) [Scheduler Type]として [Daily]、[Weekly]、または [Monthly]を選択し、必要な設定を完了します。
e) [Time Zone]ドロップダウンリストから、タイムゾーンを選択します。
f) [Save]をクリックします。

作成された SSIDスケジューラが、[SSID Scheduler]テーブルに表示されます。

ステップ 6 SSIDスケジューラを編集するには、次の手順を実行します。

a) [SSID Scheduler]テーブルから、任意の SSIDスケジューラを選択し、[Edit]をクリックします。
b) [Edit SSID Scheduler]スライドインペインで、必要な変更を行い、[Save]をクリックします。

ステップ 7 SSIDスケジューラを削除するには、SSIDスケジューラを選択して [Delete]をクリックします。

ステップ 8 SSIDスケジューラの詳細を表示するには、SSIDスケジューラを選択し、[Scheduler History]をクリックし
ます。

ネットワークの設定

40

ネットワークの設定

[SSID Scheduler]の作成

b_cisco_dna_center_ug_2_3_5_chapter17.pdf#nameddest=unique_262


[Scheduler History]を表示するには、アシュアランスパッケージをインストールする必要があり
ます。

（注）

次のタスク

ワイヤレスコントローラの SSIDスケジューラを有効にします。詳細については、ネットワー
クプロファイルへの SSIDの追加を参照してください。

ワイヤレスインターフェイスの作成

非ファブリック展開でのみワイヤレスインターフェイスを作成できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Interfaces]テーブルで、[+Add]をクリックします。

ステップ 5 [Create a Wireless Interface]スライドペインでワイヤレスインターフェイスの設定を指定します。

a) [Interface Name]フィールドに、動的なインターフェイスの名前を入力します。
b) [VLAN ID]フィールドに、このインターフェイスの VLAN IDを入力します。

ステップ 6 [保存（Save）]をクリックします。

ワイヤレスインターフェイスが作成され、[Wireless Interfaces]テーブルに表示されます。

非ファブリック展開用のインターフェイスまたは VLANグループの設
計とプロビジョニング

Cisco DNA Centerでは、異なるVLANを介して複数のブロードキャストドメインを持つネット
ワークを設定できます。同じAPのセットが同じWLANをブロードキャストする場合、ブロー
ドキャストドメインは、インターフェイスグループを介して同じWLAN上の複数の VLANに
よって制御されます。

Cisco DNA Centerインターフェイスグループは、ユーザー設定を容易にするインターフェイス
の論理グループであり、同じインターフェイスグループを複数のWLANで設定できます。そ
の一方で、APグループごとにWLANインターフェイスをオーバーライドできます。1つのイ
ンターフェイスを複数のインターフェイスグループに含めることができます。WLANは、イ
ンターフェイスまたはインターフェイスグループに関連付けることができます。
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インターフェイスグループの名前とインターフェイスの名前を同じにすることはできません。（注）

Cisco DNA Center VLANグループ機能は、VLANグループを使用してWLANを 1つまたは複
数の VLANにマッピングします。VLANグループは、ポリシープロファイルに関連付けるこ
とができます。

次の手順では、非ファブリック展開のインターフェイスまたは VLANグループを設計および
プロビジョニングする方法について説明します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 [VLAN Group]テーブルで、[Add]をクリックします。

[Add VLAN Group]スライドインペインが表示されます。

ステップ 4 有効な [VLAN Group Name]を入力し、リストから単一または複数のインターフェイスを選択して、[Save]
をクリックします。

15を超えるインターフェイスを選択すると、選択したインターフェイスが画面に正しく表示
されない場合があります。

（注）

ステップ 5 [Edit Network Profile]ページで、VLANグループが SSIDに関連付けられます。

SSIDの作成方法については、「エンタープライズワイヤレスネットワーク用 SSIDの作成」を参照して
ください。

ステップ 6 VLANグループにさらに SSIDを追加するには、[Add SSID]をクリックします。

ステップ 7 [Interface]または [VLAN]グループを選択します。

ステップ 8 [Add]アイコンをクリックして、新しいインターフェイスまたは VLANグループを作成します。

インターフェイスまたは VLANグループは FlexConnectローカルスイッチングには適用され
ません。

（注）

ステップ 9 [保存（Save）]をクリックします。

ステップ 10 [Configure Interface and VLAN]では、インターフェイス名、インターフェイスグループ名、およびイン
ターフェイスと VLANの設定に必要なその他のパラメータのリストを確認できます。

インターフェイスグループには、64を超えるインターフェイスを含めることはできません。（注）

ステップ 11 メニューアイコン（ ）をクリックして、[Provision] > [Network Devices] > [Inventory]の順に選択しま
す。

ステップ 12 デバイスを選択します。

ステップ 13 [Actions]ドロップダウンメニューから、[Provision] > [Provision Device]の順に選択します。

ステップ 14 [Assign Site]、[Configuration]、[Model Configuration]、[Advanced Configuration]、および [Summary]画面で
詳細を確認します。各画面で、[Next]をクリックして次の画面に進みます。
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ステップ 15 [展開（Deploy）]をクリックします。

[Provision Device]ダイアログボックスが表示されます。

ステップ 16 [Now]を選択し、[Apply]をクリックします。

「Task Scheduled view status in Tasks」というメッセージが表示されます。

ワイヤレス無線周波数プロファイルの作成

デフォルトの無線周波数プロファイル（低、標準、高）を使用することも、カスタムの無線周

波数プロファイルを作成することもできます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[Add]にカーソルを合わせて [Basic RF Profile]を選択します。

ステップ 5 [Create Wireless Radio Frequency Profile]ウィンドウの [Profile Name]フィールドに、RFプロファイル名を
入力します。

ステップ 6 [2.4 GHz]タブで次を設定します。

a) [2.4 GHz]トグルボタンが有効になっていることを確認します。

[2.4 GHz]トグルボタンを無効にすると、この RFプロファイルを使用するすべての AP
で、該当する無線の管理ステータスが無効になります。Cisco DNA Center

（注）

b) [Parent Profile]で、[High]、[Medium（Typica）]、[Low]、[Custom]のいずれかを選択します。（[デー
タレート（Data Rate）]および [Tx設定（Tx Configuration）]フィールドは、選択された親プロファイ
ルによって変更されます。たとえば、[High]を選択した場合、2.4 GHzのデバイスで使用可能なプロ
ファイル設定が追加されます。[Data Rate]および [Tx Configuration]の入力済みの設定を変更すると、
[Parent Profile]が自動的に [Custom]に変更されます。選択したカスタムプロファイルに対してのみ、
新しい RFプロファイルが作成されることに注意してください。

[Low]、[Medium (Typical)]、および [High]は、デフォルトのRFプロファイルです。デフォ
ルトのRFプロファイルを選択すると、デバイスで該当するRFプロファイルが使用され、
Cisco DNA Centerでは新しい RFプロファイルは作成されません。

（注）

c) [DCA Channel]は、RFグループへのチャネルの割り当てを動的に管理し、AP無線ごとに割り当てを
評価します。

• [すべて選択（Select All）]チェックボックスをオンにして、DCAチャネル [1]、[6]、および [11]
を選択します。または、チャネル番号の横にある個々のチェックボックスをオンにします。

• [詳細オプション（Advanced Options）]の下で [詳細設定を表示（Show Advanced）]をクリック
し、チャネル番号を選択します。
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• [Select All]チェックボックスをオンにして、[Advanced Options]の下にあるDCAチャネルを選択
するか、個々のチャネル番号の横にあるチェックボックスをオンにします。使用可能なチャネ

ル番号は、[2]、[3]、[4]、[5]、[7]、[8]、[9]、[10]、[12]、[13]、[14]です。

シスコワイヤレスコントローラでチャネルをグローバルに設定する必要がありま

す。

（注）

d) [Supported Data Rate]で、次を構成します。

• [Enable 802.11b data rates]チェックボックスをオンにして、802.11bデータレートを有効にしま
す。

•スライダを使用して、アクセスポイントとクライアント間でデータを送信できるレートを設定
します。使用可能なデータレートは、[1]、[2]、[5.5]、[6]、[9]、[11]、[12]、[18]、[24]、[36]、
[48]、[54]です。

e) [Mandatory Data Rates]で、個々のデータレートの横にあるチェックボックスをオンにします。最大 2
つのデータレートを選択できます。使用可能なデータレートは、[6]、[9]、[12]、[18]、[24]、[36]、
[48]、[54]です。

使用可能なデータレートは、[Supported Data Rate]で設定されたデータレートに応じて変わります。

f) [Tx Power Configuration]で、APの電力レベルと電力しきい値を設定します。

•電力レベル：APの電力を削減する必要があるかどうかを決定します。APの電力を削減すると、
同一チャネルまたは近接するチャネル上の別のAPとの同一チャネル干渉を軽減するのに役立ち
ます。[電力レベル（Power Level）]スライダを使用して、電力レベルの最小または最大値を設
定します。指定できる範囲は -10～ 30 dBmで、デフォルトは -10 dBmです。

• [TPC Power Threshold]：無線リソース管理（RRM）を使用したカットオフ信号レベルで、APの
電力を削減するかどうかを判断します。[Power Threshold]スライダを使用して電力値を増減さ
せ、APをより高い、またはより低い送信電力レートで動作させるようにします。指定できる範
囲は -50～ 80 dBMで、デフォルトのしきい値は -70 dBMです。

• RX SOP：レシーバのパケット検出開始しきい値（RX SOP）は、APの無線がパケットの変調お
よび復調を行うWi-Fi信号レベル（ dBm単位）を決定します。[RX SOP]ドロップダウンリスト
から、各 802.11バンドのしきい値を、[高（High）]、[中（Medium）]、[低（Low）]、および [自
動（Auto）]から選択します。

g) [Coverage Hole Detection]で、次のように設定します。

[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応する
無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤレ

スコントローラでプロビジョニングする必要があります。RRMの一般パラメータのモデ
ル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参照して
ください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビジョニン

グを参照してください。

（注）
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• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有効
な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を dBm
で入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な範
囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は0～100 %です。
デフォルト値は 25%です。

h) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。

Cisco AireOSワイヤレスコントローラでは、クライアント数の上限はサポートされてい
ません。

• Cisco IOS XEのバージョンが 17.7以前の場合、ワイヤレスコントローラのクライア
ント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7以降 17.9以前の場合、ワイヤレスコントローラの
クライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9以降の場合、ワイヤレスコントローラのクライア
ント数の上限は 500です。

（注）

i) [802.11ax]では、次の空間再利用パラメータを構成します。

802.11axは、Cisco IOS XE 17.6.1以降を搭載したワイヤレスコントローラでのみサポート
されます。

（注）

• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）機
能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォル
ト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。

SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポート
されます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBmで
入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBmで
入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 7 [5 GHz]タブで次を設定します。
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a) [5 GHz]トグルボタンが有効になっていることを確認します。

[5 GHz]トグルボタンを無効にすると、Cisco DNA Centerは、この RFプロファイルを
使用するすべての APで、該当する無線の管理ステータスを無効にします。

（注）

b) [親プロファイル（Parent Profile）]ドロップダウンリストから、[高（High）]、[中（標準）
（Medium (Typical)）]、[低（Low）]、または [カスタム（Custom）]を選択します。（[データレー
ト（Data Rate）]および [Tx設定（Tx Configuration）]フィールドは、選択された親プロファイルに
よって変更されます。たとえば、[高（High）]を選択した場合、2.4 GHzのデバイスで使用可能な
設定が追加されます。[Data Rate]フィールドおよび [Tx Configuration]フィールドの入力済みの設定
を変更すると、[Parent Profile]が自動的に [Custom]に変更されます。選択したカスタムプロファイ
ルに対してのみ、新しい RFプロファイルが作成されます。

[Low]、[Medium (Typical)]、および [High]は、デフォルトの RFプロファイルです。デ
フォルトの RFプロファイルを選択するとデバイスに既に存在するそれぞれの RFプロ
ファイルが使用され、Cisco DNA Centerでは新しい RFプロファイルは作成されませ
ん。

（注）

c) [Channel Width]ドロップダウンリストから、チャネル帯域幅オプションとして [Best]、[20 MHz]、
[40 MHz]、[80 MHz]、または [160 MHz]のいずれかを選択します。

d) [Zero Wait DFS]チェックボックスをオンにして、5 GHz無線帯域の APが待機時間なしで新しい
チャネルに切り替えることを許可します。

Cisco DNA Centerは、Cisco IOS XEリリース 17.9.1以降を実行するシスコワイヤレス
コントローラのゼロウェイト DFSをサポートします。

（注）

e) [DCA Channels]で次を設定して、チャネルの割り当てを管理します。

シスコワイヤレスコントローラでチャネルをグローバルに設定する必要があります。（注）

• [Select All]チェックボックスをオンにして、DCAチャネルUNII-1 36-48、UNII-2 52-144、およ
びUNII-3 149-173を選択します。または、チャネル番号の横にある個々のチェックボックスを
オンにします。

• [Show Advanced]をクリックして、各バンドのチャネル番号を選択します。

• [UNII-1 36-48]：UNII-1バンドで使用可能なチャネルは、[36]、[40]、[44]、[48]です。[UNII-1
36-48]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルのチェックボッ
クスをオンにして、個別に選択します。

• [UNII-2 52-144]：UNII-2バンドで使用可能なチャネルは、[52]、[56]、[60]、[64]、[100]、[104]、
[108]、[112]、[116]、[120]、[124]、[128]、[132]、[136]、[140]、[144]です。[UNII-2 52-144]
チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルのチェックボックスを

オンにして、個別に選択します。

• [UNII-3 149-165]：UNII-3バンドで使用可能なチャネルは、[149]、[153]、[157]、[161]、[165]
です。[UNII-3 149-165]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネ
ルのチェックボックスをオンにして、個別に選択します。
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f) アクセスポイントとクライアント間でデータを転送できるレートを設定するには、[サポートされ
ているデータレート（Supported Data Rate）]スライダを使用します。使用可能なデータレートは、
[6]、[9]、[12]、[18]、[24]、[36]、[48]、[54]です。

g) [Mandatory Data Rates]で、個々のデータレートの横にあるチェックボックスをオンにします。最大
2つのデータレートを選択できます。使用可能なデータレートは、[6]、[9]、[12]、[18]、[24]、
[36]、[48]、[54]です。

使用可能なデータレートは、[Supported Data Rate]で設定されたデータレートに応じて変わります。

h) [Tx Power Configuration]で、APの電力レベルと電力しきい値を設定できます。

• [Power Level]：APの電力を削減する必要があるかどうかを判断します。APの電力を削減する
と、同一チャネルまたは近接するチャネル上の別のAPとの同一チャネル干渉を軽減するのに
役立ちます。[電力レベル（Power Level）]スライダを使用して、電力レベルの最小または最大
値を設定します。指定できる範囲は -10～ 30 dBmで、デフォルトは -10 dBmです。

• [TPC Power Threshold]：無線リソース管理（RRM）を使用したカットオフ信号レベルで、AP
の電力を削減するかどうかを判断します。[Power Threshold]スライダを使用して電力値を増減
させ、APをより高い、またはより低い送信電力レートで動作させるようにします。指定でき
る範囲は -50～ 80 dBMで、デフォルトのしきい値は -70 dBMです。

• [RX SOP]：レシーバのパケット検出開始しきい値（RX SOP）は、APの無線がパケットを復
調してデコードする dBm単位のWi-Fi信号レベルを決定します。[RX SOP]ドロップダウンリ
ストから、各 802.11バンドのしきい値を、[高（High）]、[中（Medium）]、[低（Low）]、お
よび [自動（Auto）]から選択します。

i) [Coverage Hole Detection]で、次のように設定します。

[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応す
る無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤ

レスコントローラでプロビジョニングする必要があります。RRMの一般パラメータの
モデル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参
照してください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビ

ジョニングを参照してください。

（注）

• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有
効な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を
dBmで入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な
範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は 0～ 100 %で
す。デフォルト値は 25%です。

j) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。

ネットワークの設定

47

ネットワークの設定

ワイヤレス無線周波数プロファイルの作成

b_cisco_dna_center_ug_2_3_5_chapter12.pdf#nameddest=unique_269
b_cisco_dna_center_ug_2_3_5_chapter17.pdf#nameddest=unique_270
b_cisco_dna_center_ug_2_3_5_chapter17.pdf#nameddest=unique_270


Cisco AireOSワイヤレスコントローラでは、クライアント数の上限はサポートされて
いません。

• Cisco IOS XEのバージョンが 17.7以前の場合、ワイヤレスコントローラのクライ
アント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7以降 17.9以前の場合、ワイヤレスコントローラ
のクライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9以降の場合、ワイヤレスコントローラのクライ
アント数の上限は 500です。

（注）

k) [Flexible Radio Assignment（FRA）]で、[Client Aware]チェックボックスをオンにして、クライア
ント認識機能を有効にします。

この機能は5 GHzの専用無線を監視し、クライアントの負荷がしきい値を超えると、FRAがモニ
ターロールから 5 GHzロールに自動的に切り替わり、セルの容量をオンデマンドで効率的に倍増
します。容量の心配がなくなり、Wi-Fiの負荷が正常に戻ると、無線で前のロールが再開されま
す。

[Tools] > [Model Config Editor] > [Wireless] > [RRM FRA Configuration]で、対応する無
線バンドの FRAを有効にし、それを管理するワイヤレスコントローラでプロビジョニ
ングする必要があります。RRM FRAパラメータのモデル構成設計の詳細については、
RRM FRAパラメータのモデルkousei設定設計の作成を参照してください。プロビジョ
ニングの詳細については、ワイヤレスデバイスのプロビジョニングを参照してくださ

い。

（注）

クライアント対応機能を有効にする場合は、次のように構成します。

• [Client Select (%)]フィールドに、クライアント選択の値を入力します。有効な範囲は 0～ 100%
です。デフォルト値は 50%です。

• [Client Reset (%)]フィールドに、クライアントのリセット値を入力します。有効な範囲は 0～
100 %です。デフォルト値は 5パーセントです。

l) [802.11ax]では、次の空間再利用パラメータを構成します。

802.11axは、Cisco IOS XE 17.6.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

（注）

• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）
機能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォ
ルト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。
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SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 8 [6 GHz]タブで次を設定します。

a) [6 GHz]トグルボタンが有効になっていることを確認します。

6 GHz無線は、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでしかサ
ポートされていません。[6 GHz]トグルボタンを無効にすると、Cisco DNA Centerは、
この RFプロファイルを使用するすべての APで、該当する無線の管理ステータスを無
効にします。

（注）

b) [Enable PSC Enforcing]トグルボタンを有効にして、優先スキャンチャネル（PSC）の適用を許可し
ます。

PSCの適用は、PSC対応チャネルに優先順位を付けることにより、6 GHzデバイスの接続を改善し
ます。

PSCの適用を有効にすると、非 PSCチャネルの隣のチェックボックスがグレー表示に
なります。

（注）

c) [DCA Channels]で次を設定して、チャネルの割り当てを管理します。

• [Select All]チェックボックスをオンにしてすべての DCAチャネルを含めるか、個々のチェッ
クボックスをオンにして個々の DCAチャネルを選択します。

• UNII-5 1-93

• UNII-6 97-113

• UNII-7 117-185

• UNII-8 189-233

• [Show Advanced]をクリックして、各バンドのチャネル番号を選択します。

シスコワイヤレスコントローラでチャネルをグローバルに設定する必要があります。（注）

d) アクセスポイントとクライアント間でデータを転送できるレートを設定するには、[サポートされ
ているデータレート（Supported Data Rate）]スライダを使用します。使用可能なデータレートは、
[6]、[9]、[12]、[18]、[24]、[36]、[48]、[54]です。

e) [Mandatory Data Rates]で、個々のデータレートの横にあるチェックボックスをオンにします。最大
2つのデータレートを選択できます。使用可能なデータレートは、[6]、[9]、[12]、[18]、[24]、
[36]、[48]、[54]です。

使用可能なデータレートは、[Supported Data Rate]で設定されたデータレートに応じて変わります。
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f) [Tx Power Configuration]で、APの電力レベルと電力しきい値を設定できます。

• [Power Level]：APの電力を削減する必要があるかどうかを判断します。APの電力を削減する
と、同一チャネルまたは近接するチャネル上の別のAPとの同一チャネル干渉を軽減するのに
役立ちます。[電力レベル（Power Level）]スライダを使用して、電力レベルの最小または最大
値を設定します。指定できる範囲は -10～ 30 dBmで、デフォルトは -10 dBmです。

• [TPC Power Threshold]：無線リソース管理（RRM）を使用したカットオフ信号レベルで、AP
の電力を削減するかどうかを判断します。[Power Threshold]スライダを使用して電力値を増減
させ、APをより高い、またはより低い送信電力レートで動作させるようにします。指定でき
る範囲は -50～ 80 dBMで、デフォルトのしきい値は -70 dBMです。

• [RX SOP]：レシーバのパケット検出開始しきい値（RX SOP）は、APの無線がパケットを復
調してデコードする dBm単位のWi-Fi信号レベルを決定します。[RX SOP]ドロップダウンリ
ストから、各 802.11バンドのしきい値を、[高（High）]、[中（Medium）]、[低（Low）]、お
よび [自動（Auto）]から選択します。

g) [Coverage Hole Detection]で、次のように設定します。

[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応す
る無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤ

レスコントローラでプロビジョニングする必要があります。RRMの一般パラメータの
モデル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参
照してください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビ

ジョニングを参照してください。

（注）

• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有
効な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を
dBmで入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な
範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は 0～ 100 %で
す。デフォルト値は 25%です。

h) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。

Cisco AireOSワイヤレスコントローラでは、クライアント数の上限はサポートされて
いません。

• Cisco IOS XEのバージョンが 17.7以前の場合、ワイヤレスコントローラのクライ
アント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7以降 17.9以前の場合、ワイヤレスコントローラ
のクライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9以降の場合、ワイヤレスコントローラのクライ
アント数の上限は 500です。

（注）
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i) [Flexible Radio Assignment（FRA）]で、次の手順を実行します。

• [Tools] > [Model Config Editor] > [Wireless] > [RRM FRA Configuration]で、対応す
る無線バンドの FRAを有効にし、それを管理するワイヤレスコントローラでプロ
ビジョニングする必要があります。RRM FRAパラメータのモデル構成設計の詳細
については、RRM FRAパラメータのモデルkousei設定設計の作成を参照してくだ
さい。プロビジョニングの詳細については、ワイヤレスデバイスのプロビジョニン

グを参照してください。

• FRAは、Cisco IOS XE 17.9.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

（注）

• [Client Reset Count]フィールドに、クライアントのリセット回数の値を入力します。有効な範
囲は 0～ 10です。デフォルト値は 1です。

• [Client Utilization Threshold（%）]フィールドに、クライアントの使用率のしきい値を入力しま
す。有効な範囲は 0～ 100 %です。デフォルト値は 5パーセントです。

j) 802.11axでは、次の複数の基本サービスセット識別子（BSSID）および空間再利用パラメータを構
成します。

• [6 GHz Discovery Frames]ドロップダウンリストから、必要なオプションを [None]、[Broadcast
Probe Response]、および [FILS Discovery]から選択します。

6 GHz無線が唯一の動作可能な無線である場合は、6 GHz検出フレームが必要です。6 GHz検
出フレームの詳細については、[Learn More]をクリックしてください。

• [Broadcast Probe Response Interval（msec）]フィールドに、ブロードキャストプローブ応答間隔
をミリ秒単位で入力します。有効な範囲は 5ミリ秒から 25ミリ秒です。デフォルト値は 20ミ
リ秒です。

• [MULTI BSSID]で、チェックボックスをオンにして、次のパラメータを有効にします。

•ダウンリンク OFDMA

•アップリンク OFDMA

•ダウンリンクMU-MIMO

•アップリンクMU-MIMO

•ターゲット起動時間

• TWTブロードキャストのサポート

対応する無線バンドの[Tools] > [Model Config Editor] > [Wireless] > [Dot11ax
Configuration]でBSSIDを有効にし、管理しているワイヤレスコントローラでそれ
をプロビジョニングする必要があります。Dot11axのモデル構成設計の詳細につい
ては、Dot11ax設定のモデル設定設計の作成を参照してください。プロビジョニン
グの詳細については、ワイヤレスデバイスのプロビジョニングを参照してくださ

い。

（注）
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• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）
機能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォ
ルト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。

SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 9 [Save]をクリックします。

ステップ 10 プロファイルをデフォルトの RFプロファイルとしてマークするには、[Profile Name]チェックボックス
をオンにし、[Mark Default]をクリックします。

ステップ 11 [警告（Warning）]ウィンドウで [OK]をクリックします。

基本無線周波数プロファイルの編集または削除

次の手順では、基本 RFプロファイルを編集または削除する方法について説明します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]領域で、[Basic RF Profile]タブをクリックします。

[Basic RF Profile]テーブルには、[Profile Name]、[Type]、[2.4 GHz Data Rates]、[5 GHz Data
Rates]、[6 GHz Data Rates]、[Channel Width]、および [Profile Type]に基づいて作成された基
本 RFプロファイルの数がリストされます。

（注）

ステップ 5 編集する基本プロファイル名の横にあるチェックボックスをオンにします。

ステップ 6 [Actions]ドロップダウンリストから、[Edit/View]を選択します。

一度に 1つの基本 RFプロファイルを編集できます。（注）

ステップ 7 [Edit Wireless Radio Frequency Profile]ウィンドウで、基本 RFプロファイル設定を構成します。詳細につ
いては、ワイヤレス無線周波数プロファイルの作成（43ページ）を参照してください。

ステップ 8 [保存（Save）]をクリックします。
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ステップ 9 基本 RFプロファイルを削除するには、基本 RFプロファイル名の横にあるチェックボックスをオンにし
ます。

ステップ 10 [Actions]ドロップダウンリストから、[Delete]を選択してから [Yes]をクリックします。

ステップ 11 基本 RFプロファイルをデフォルトとしてマークするには、基本 RFプロファイル名の横にあるチェック
ボックスをオンにします。

ステップ 12 [Action]ドロップダウンリストから、[Mark Default]を選択してから [Yes]をクリックします。

AI無線周波数プロファイルを設定するための前提条件
•システム設定でCisco AI Network Analyticsを有効にする必要があります。詳細については、

Cisco DNA Center管理者ガイドの「Cisco AI Network Analyticsデータ収集の設定」を参照
してください。

•システム設定の [Cisco AI Analytics]で [AI Enhanced RRM]を有効にする必要があります。
メニューアイコン（ ）をクリックして、 [System] > [Settings] > [External Services] >
[Cisco AI Analytics]の順に選択します。

[Cisco AI Analytics]ウィンドウの [AI ENHANCED RRM]エリアで、トグルボタンをクリッ
クして AI拡張 RRMを有効にします。

• Cisco AI RFプロファイルは、Cisco IOS XE 17.7.1以降を搭載したCisco Catalyst 9800シリー
ズワイヤレスコントローラでのみサポートされています。

3つの帯域すべて（2.4 GHz、5 GHz、および 6 GHz）の [Group
Mode]オプションが、ワイヤレスコントローラで[Auto]または
[Leader]として設定されていることを確認します。

（注）

• Cisco AI RFプロファイルは Cisco IOS XE 17.9.1以降を搭載したワイヤレスコントローラ
で、6-GHz無線のみサポートされています。

•スーパー管理者またはネットワーク管理者である必要があります。

AI無線周波数プロファイルの作成
次の手順では、建物の AI無線周波数プロファイルの作成方法について説明します。

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。
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ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[Add]にカーソルを合わせて [AI RF Profile]を選択します。

ステップ 5 [Create AI Radio Frequency Profile]ウィンドウの [Profile Name]フィールドに、RFプロファイル名を入
力します。

ステップ 6 [Basic Settings]の[Radio Frequency Settings area]エリアで、[2.4 GHz]、[5 GHz]、[6 GHz]チェックボック
スをオンにします。

無線周波数はデフォルトでオンになっています。無線周波数をオフにすると、その無線周波数のRF設定
が無効になります。

[6 GHz]無線帯域の AI RFプロファイルは、Cisco IOS XE 17.9.1以降を搭載した Cisco Catalyst
9800シリーズワイヤレスコントローラでサポートされています。

（注）

ステップ 7 [Busy Hours]エリアで、サイトのタイムゾーンの開始時刻と終了時刻を定義します。

ビジー時間は、建物のタイムゾーンによって異なります。それぞれの建物のネットワーク設

定でタイムゾーンを構成する必要があります。

（注）

ステップ 8 [Busy Hour Sensitivity]エリアで、[Low]、[Medium]、または [High]オプションボタンをクリックして、ビ
ジー時間間隔の無線リソース管理（RRM）感度のしきい値を定義します。

ステップ 9 [Enable RF Settings]エリアで、[2.4 GHz]、[5 GHz]または [6 GHz]列の下にあるトグルボタンをクリック
して、それぞれの RF設定の無線帯域を有効または無効にします。

サポートされている RF設定は次のとおりです。

• [Flexible Radio Assignment (FRA)]：FRAは帯域ごとの無線カバレッジを最適化し、冗長無線の最適な
ロール割り当てを決定します。

• [Dynamic Channel Assignment (DCA)]：DCAは、RFグループへのチャネルの割り当てを動的に管理
し、AP無線ごとに割り当てを評価します。

• [Transmit Power Control (TPC)]：TPCは APの電力を管理および送信します。また、干渉の低減中に
SNRを最大化します。

• [Dynamic Bandwidth Selection (DBS)]：DBSは、チャネル幅を監視および調整して、パフォーマンス
と干渉のバランスをとります。
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• FRAの [2.4 GHz]無線帯域を無効にすると、FRAの [5 GHz]無線バンドが自動的に無効に
なります。逆の場合も同様です。

• DCAの [5 GHz]無線帯域を無効にすると、FRAの [2.4 GHz]無線帯域と FRAと DBSの
[5 GHz]無線帯域が無効になります。

• DCAおよび TPCの [2.4 GHz]無線帯域と、DCA、TPC、および DBSの [5 GHz]無線帯域
を個別に有効にできます。[5 GHz]無線帯域の場合、DCAと DBSが無効になっていると
きに DBSを有効にすると、DCAも有効になります。

• DCAおよびDBS RF設定で [6 GHz]無線帯域をまとめて有効または無効にできます。TPC
の [6 GHz]無線帯域を個別に有効にできます。

• FRAは、[6 GHz]無線帯域ではサポートされていません。

（注）

ステップ 10 [Advanced]を展開し、[2.4 GHz]トグルボタンをクリックします。

a) [DCA Channel]エリアで、[Select All]チェックボックスをオンにして、DCAチャネル [1]、[6]、お
よび [11]を選択します。または、チャネル番号の横にある個々のチェックボックスをオンにしま
す。

b) [Advanced Options]エリアで、[Select All]チェックボックスをオンにして、すべてのDCAチャネル
を選択します。

c) [Show Advanced]をクリックして、残りのチャネル番号を選択します。
d) 個々のチャネル番号の横にあるチェックボックスをオンにします。プロファイルで使用可能なチャ

ネル番号は、[2]、[3]、[4]、[5]、[7]、[8]、[9]、[10]、[12]、[13]、[14]です。
e) [Supported Data Rate]エリアで、次を構成します。

• [Enable 802.11b data rates]チェックボックスをオンにして、802.11bデータレートを有効にしま
す。このアクションにより、[Mandatory Data Rates]エリアの [802.11b supported data rate]チェッ
クボックスも有効になります。

•スライダを使用して、APとクライアント間でデータを送信できるレートを設定します。使用
可能なデータレートは、[1]、[2]、[5.5]、[6]、[9]、[11]、[12]、[18]、[24]、[36]、[48]、[54]で
す。

f) [Mandatory Data Rates]エリアで、個々のデータレートの横にあるチェックボックスをオンにしま
す。最大 2つのデータレートを選択できます。使用可能なデータレートは、[1]、[2]、[5.5]、[6]、
[9]、[11]、[12]、[18]、[24]、[36]、[48]、[54]です。

g) [Tx Power Configuration]エリアで、次を設定します。

• [Power Level]：APの電力を削減する必要があるかどうかを判断します。APの電力を削減する
と、同一チャネル干渉を軽減できます。[電力レベル（Power Level）]スライダを使用して、電
力レベルの最小または最大値を設定します。範囲は、-10～ 30 dBmです。最小のデフォルト
は -10 dBmで、最大のデフォルトは 30 dBmです。

• [TPC Power Threshold]：RRMを使用したカットオフ信号レベルです。APの電力レベルを削減
するかどうかを判断します。[TPC Power Threshold]スライダを使用して電力値を増減させ、AP
をより高い、またはより低い送信電力レートで動作させるようにします。指定できる範囲は

-50～ 80 dBmで、デフォルトのしきい値は -70 dBmです。
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• RX SOP：レシーバのパケット検出開始しきい値（RX SOP）は、APの無線がパケットの変調
および復調を行うWi-Fi信号レベル（ dBm単位）を決定します。[RX SOP]ドロップダウンリ
ストから、各 802.11バンドのしきい値を、[High]、[Medium]、[Low]、および [Auto]から選択
します。

h) [Coverage Hole Detection]で、次のように設定します。

[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応す
る無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤ

レスコントローラでプロビジョニングする必要があります。RRMの一般パラメータの
モデル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参
照してください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビ

ジョニングを参照してください。

（注）

• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有
効な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を
dBmで入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な
範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は 0～ 100 %で
す。デフォルト値は 25%です。

i) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。

• Cisco IOS XEのバージョンが 17.7.1以前の場合、ワイヤレスコントローラのクラ
イアント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7.1以降 17.9.1以前の場合、ワイヤレスコントロー
ラのクライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9.1以降の場合、ワイヤレスコントローラのクラ
イアント数の上限は 500です。

（注）

j) [802.11ax]では、次の空間再利用パラメータを構成します。

802.11axは、Cisco IOS XE 17.6.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

（注）

• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）
機能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォ
ルト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。
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SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 11 [Advanced]エリアで、[5 GHz]トグルボタンをクリックします。

a) [Zero Wait DFS]チェックボックスをオンにすると、5 GHz無線の APを待機時間なしで新しいチャ
ネルに切り替えることができます。

Cisco DNA Centerは、Cisco IOS XEリリース 17.9.1以降を実行するシスコワイヤレス
コントローラのゼロウェイト DFSをサポートします。

（注）

b) [DBS Max Width]スライダを使用して、AI RFプロファイルのチャネル幅を設定します。

使用可能なチャネル幅オプションは、[20 MHz]、[40 MHz]、[80 MHz]、または [160 MHz]です。

[Auto Channels Logic]エリアには、Unlicensed National Information Infrastructure（UNII）無線帯域で
使用可能なチャネル幅のチャネルが色分けされて表示されます。

DBSが有効な場合にのみ、[DBS Max Width]を選択できます。

DBSを無効にすると、Cisco DNA Centerでは静的チャネル幅を選択できます。

c) [DCA Channel]を設定して、次のチャネルの割り当てを管理します。

• [UNII-1 36-48]：UNII-1バンドで使用可能なチャネルは、[36]、[40]、[44]、[48]です。

• [UNII-2 52-144]：UNII-2バンドで使用可能なチャネルは、[52]、[56]、[60]、[64]、[100]、[104]、
[108]、[112]、[116]、[120]、[124]、[128]、[132]、[136]、[140]、[144]です。

• [UNII-3 149-165]：UNII-3バンドで使用可能なチャネルは、[149]、[153]、[157]、[161]、[165]
です。

d) [Select All]チェックボックスをオンにしてすべてのDCAチャネルを含めるか、個々のチェックボッ
クスをオンにして個々の DCAチャネルを選択します。

e) [Show Advanced]をクリックして、それぞれの DCAチャネル番号を確認、選択します。

• [UNII-136-48]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルのチェッ
クボックスをオンにして、個別に選択します。

• [UNII-136-48]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルのチェッ
クボックスをオンにして、個別に選択します。

• [UNII-3 149-165]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルの
チェックボックスをオンにして、個別に選択します。
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f) APとクライアント間でデータを転送できるレートを設定するには、[Supported Data Rate]スライダ
を使用します。使用可能なデータレートは、[6]、[9]、[11]、[12]、[18]、[24]、[36}、[48}、[54]
です。

g) [Mandatory Data Rates]エリアで、個々のデータレートの横にあるチェックボックスをオンにしま
す。最大 2つのデータレートを選択できます。使用可能なデータレートは、[6]、[9]、[11]、[12]
、[18]、[24]、[36}、[48}、[54]です。

h) [Tx Power Configuration]エリアで、[Power Level]、[Power Threshold]、および [RX SOP]を設定しま
す。

• [電力レベル（Power Level）]スライダを使用して、電力レベルの最小または最大値を設定しま
す。範囲は、-10～ 30 dBmです。最小のデフォルトは -10 dBmで、最大のデフォルトは 30
dBmです。

• [TPC Power Threshold]スライダを使用して電力値を増減させ、APをより高い、またはより低
い送信電力レートで動作させるようにします。指定できる範囲は -50～ 80 dBmで、デフォル
トのしきい値は -70 dBmです。

• [RX SOP]ドロップダウンリストで、しきい値を、[High]、[Medium]、[Low]、および [Auto]か
ら選択します。

i) [Coverage Hole Detection]で、次のように設定します。

[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応す
る無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤ

レスコントローラでプロビジョニングする必要があります。RRMの一般パラメータの
モデル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参
照してください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビ

ジョニングを参照してください。

（注）

• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有
効な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を
dBmで入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な
範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は 0～ 100 %で
す。デフォルト値は 25%です。

j) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。
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• Cisco IOS XEのバージョンが 17.7.1以前の場合、ワイヤレスコントローラのクラ
イアント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7.1以降 17.9.1以前の場合、ワイヤレスコントロー
ラのクライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9.1以降の場合、ワイヤレスコントローラのクラ
イアント数の上限は 500です。

（注）

k) [802.11ax]では、次の空間再利用パラメータを構成します。

802.11axは、Cisco IOS XE 17.6.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

（注）

• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）
機能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォ
ルト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。

SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 12 [Advanced]エリアで、[6 GHz]トグルボタンをクリックします。

a) [DBS Width]スライダを使用して、AI RFプロファイルの最小および最大のチャネル幅を設定しま
す。

使用可能なチャネル幅オプションは、[20 MHz]、[40 MHz]、[80 MHz]、または [160 MHz]です。

[Auto Channels Logic]エリアには、UNII無線帯域で使用可能なチャネル幅のチャネルが色分けされ
て表示されます。

DBSが有効な場合にのみ、[DBS Width]を選択できます。

b) [Enable PSC Enforcing]トグルボタンを有効にして、優先スキャンチャネル（PSC）の適用を許可し
ます。

PSCの適用は、PSC対応チャネルに優先順位を付けることにより、6 GHzデバイスの接続を改善し
ます。
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PSCの適用を有効にすると、非 PSCチャネルの隣のチェックボックスがグレー表示に
なり、PSCチャネルの隣のチェックボックスがデフォルトでオンになります。必要に
応じて、使用したい PSCチャネルのチェックボックスをオフにできます。

（注）

c) [DCA Channels]を設定して、次のチャネルの割り当てを管理します。

• UNII-5 1-93：UNII-5帯域で使用できるチャネルは、1、5、9、13、17、21、25、29、33、
37、41、45、49、53、57、61、65 、69、73、77、81、85、89、および 93。

• UNII-6 97-113：UNII-6帯域で使用できるチャネルは、97、101、105、109、および 113で
す。

• UNII-7 117-185：UNII-7帯域で使用可能なチャネルは 117、121、125、129、133、137、141
、145、149、153、157、161、165、169、173、177、181、および 185。

• UNII-8 189-233：UNII-8帯域で使用できるチャネルは、189、193、197、201、205、209、
213、217、221、225、229、および 233です。

d) [Select All]チェックボックスをオンにしてすべてのDCAチャネルを含めるか、個々のチェックボッ
クスをオンにして個々の DCAチャネルを選択します。

e) [Show Advanced]をクリックして、残りの DCAチャネル番号を選択します。

• [UNII-5 1-93]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルのチェッ
クボックスをオンにして、個別に選択します。

• [UNII-7 117-185]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルの
チェックボックスをオンにして、個別に選択します。

• [UNII-8 189-233]チェックボックスをオンにしてすべてのチャネルを含めるか、チャネルの
チェックボックスをオンにして、個別に選択します。

f) APとクライアント間でデータを転送できるレートを設定するには、[Supported Data Rate]スライダ
を使用します。使用可能なデータレートは、[6]、[9]、[12]、[18]、[24]、[36]、[48]、[54]です。

g) [Tx Power Configuration]エリアで、[Power Level]、[TPC Power Threshold]、および [RX SOP]を設定
します。

• [電力レベル（Power Level）]スライダを使用して、電力レベルの最小または最大値を設定しま
す。指定できる範囲は -10～ 30 dBmで、デフォルトは -10 dBmです。

• [TPC Power Threshold]スライダを使用して電力値を増減させ、APをより高い、またはより低
い送信電力レートで動作させるようにします。指定できる範囲は -50～ 80 dBmで、デフォル
トのしきい値は -70 dBmです。

• [RX SOP]ドロップダウンリストで、しきい値を、[High]、[Medium]、[Low]、および [Auto]か
ら選択します。

h) [Coverage Hole Detection]で、次のように設定します。
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[Tools] > [Model Config Editor] > [Wireless] > [RRM General Configuration]で、対応す
る無線バンドのカバレッジホール検出をグローバルで有効にし、それを管理するワイヤ

レスコントローラでプロビジョニングする必要があります。RRMの一般パラメータの
モデル構成設計の詳細については、RRM一般パラメータのモデル設定設計の作成を参
照してください。プロビジョニングの詳細については、ワイヤレスデバイスのプロビ

ジョニングを参照してください。

（注）

• [Minimum Client Level（clients）]フィールドに、クライアントの最小数の値を入力します。有
効な範囲は 1～ 200です。デフォルト値は 3です。

• [Data RSSI Threshold (dBm)]フィールドに、データの受信信号強度表示（RSSI）しきい値を
dBmで入力します。有効な範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Voice RSSI Threshold (dBm)]フィールドに、音声 RSSIしきい値を dBmで入力します。有効な
範囲は -90 dBm～ -60 dBmです。デフォルト値は -80 dBmです。

• [Exception Level（%）]フィールドに、例外レベルを入力します。有効な範囲は 0～ 100 %で
す。デフォルト値は 25%です。

i) [Max Client]フィールドに、クライアント数の上限値を入力します。有効な範囲は 0～ 500です。

• Cisco IOS XEのバージョンが 17.7.1以前の場合、ワイヤレスコントローラのクラ
イアント数の上限は 200です。

• Cisco IOS XEのバージョンが 17.7.1以降 17.9.1以前の場合、ワイヤレスコントロー
ラのクライアント数の上限は 400です。

• Cisco IOS XEのバージョンが 17.9.1以降の場合、ワイヤレスコントローラのクラ
イアント数の上限は 500です。

（注）

j) 802.11axでは、次の複数の基本サービスセット識別子（BSSID）および空間再利用パラメータを構
成します。

• [6 GHz Discovery Frames]ドロップダウンリストから、必要なオプションを [None]、[Broadcast
Probe Response]、および [FILS Discovery]から選択します。

6 GHz無線が唯一の動作可能な無線である場合は、6 GHz検出フレームが必要です。6 GHz検
出フレームの詳細については、[Learn More]をクリックしてください。

• [Broadcast Probe Response Interval（msec）]フィールドに、ブロードキャストプローブ応答間隔
をミリ秒単位で入力します。有効な範囲は 5ミリ秒から 25ミリ秒です。デフォルト値は 20ミ
リ秒です。

• [MULTI BSSID]で、チェックボックスをオンにして、次のパラメータを有効にします。

•ダウンリンク OFDMA

•アップリンク OFDMA

•ダウンリンクMU-MIMO
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•アップリンクMU-MIMO

•ターゲット起動時間

• TWTブロードキャストのサポート

対応する無線バンドの[Tools] > [Model Config Editor] > [Wireless] > [Dot11ax
Configuration]でBSSIDを有効にし、管理しているワイヤレスコントローラでそれ
をプロビジョニングする必要があります。Dot11axのモデル構成設計の詳細につい
ては、Dot11ax設定のモデル設定設計の作成を参照してください。プロビジョニン
グの詳細については、ワイヤレスデバイスのプロビジョニングを参照してくださ

い。

（注）

• [OBSS PD]チェックボックスをオンにして、オーバーラップ BSSパケット検出（OBSS-PD）
機能を有効にします。

• [Non-SRG OBSS PD Max Threshold (dBm)]フィールドに、非空間再利用グループ（SRG）OBSS-PD
最大しきい値の値を dBm単位で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォ
ルト値は -62 dBmです。

• [SRG OBSS-PD]チェックボックスをオンにして、SRG OBSS-PD機能を有効にします。

SRG OBSS-PDは、Cisco IOS XE 17.7.1以降を搭載したワイヤレスコントローラでのみサポー
トされます。

• [SRG OBSS PD Min Threshold (dBm)]フィールドに、SRG OBSS-PD最小しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -82 dBmです。

• [SRG OBSS PD Max Threshold (dBm)]フィールドに、SRG OBSS-PD最大しきい値の値を dBm
で入力します。有効な範囲は -82 dBm～ -62 dBmです。デフォルト値は -62 dBmです。

ステップ 13 [Save]をクリックします。

AI無線周波数プロファイルの編集

次の手順では、AI RFプロファイルを編集する方法について説明します。

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[AI RF Profile]タブをクリックします。
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[AI RF Profile]テーブルには、[Profile Name]、[Busy Hours]、[Busy Hour Sensitivity]、[FRA]、[DCA]、[DBS]、
[TPC]、および [Mapped Buildings]に基づいて作成された AI RFプロファイルの数がリストされます。

ステップ 5 編集する AI RFプロファイル名の横にあるチェックボックスをオンにします。

一度に 1つの AI RFプロファイルを編集できます。

ステップ 6 [Edit/View]をクリックします。

ステップ 7 [Edit AI RF Profile]ウィンドウで、AI RFプロファイル設定を構成します。詳細については、AI無線周波数
プロファイルの作成（53ページ）を参照してください。

ステップ 8 [Save]をクリックします。

AI無線周波数プロファイルの削除

次の手順では、AI RFプロファイルを削除する方法について説明します。

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[AI RF Profile]タブをクリックします。

[AI RF Profile]テーブルには、[Profile Name]、[Busy Hours]、[Busy Hour Sensitivity]、[FRA]、[DCA]、[DBS]、
[TPC]、および [Mapped Buildings]に基づいて作成された AI RFプロファイルの数がリストされます。

ステップ 5 AI RFプロファイルを削除するには、削除する AI RFプロファイルの横にあるチェックボックスをオンに
します。

ステップ 6 [Delete]をクリックし、[Yes]をクリックします。

Cisco DNA Centerでは、建物にすでに割り当てられている AI RFプロファイルを削除すること
はできません。

（注）

AI無線周波数プロファイルの構成
次の手順では、AI RFプロファイルを建物に割り当てる方法について説明します。
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始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Workflows] > [Configure AI RF Profile]の順に選択します。

ステップ 2 [Assign AI RF Profiles]ウィンドウで、[Let's Do it]をクリックしてワークフローに直接移動します。

ステップ 3 [Configure AI RF Profile]ウィンドウの [Task Name]フィールドにタスク名を入力します。

ステップ 4 [Select Locations to Assign AI RF Profiles]ウィンドウで、AI対応 RFプロファイルを割り当てる場所を選
択します。[Find Hierarchy]フィールドに名前を入力してサイトを検索するか、[Global]を展開してサイト
を選択します。

[Site selection summary]テーブルには、サイト階層内のサイト選択に基づいてサイトがリストされ、選択
されたサイトの [Selected Location]と [Impacted Location]が表示されます。

• [Selected Locations]：AI RFプロファイルが有効になっている場所。

• [Impacted Locations]：選択した場所と同じワイヤレスコントローラによって部分的に管理されている
場所。

コントローラが複数の建物を管理していて、1つの建物でのみ AI RFプロファイルを有
効にすると、Cisco DNA Centerは自動的に他の建物で同じ AI RFプロファイルを有効に
します。

たとえば、2つのコントローラが 3つの建物を管理していて、1つの建物で AI RFプロ
ファイルを有効にすると、Cisco DNA Centerは自動的に他の 2つの建物で同じ AI RFプ
ロファイルを有効にします。

（注）

ステップ 5 [Select AI RF Profiles to assign]ウィンドウの [Building]テーブルには、[Location]、[Floors]、[Current RF
Profiles]、および [Replace with AI RF Profiles]に基づいた AI RFプロファイルが一覧表示されます。

a) [Building]テーブルで、場所の横にあるチェックボックスをオンにして、AI RFプロファイルを選択
します。

b) 場所に基づいて、[Replace with AI RF Profiles]の下のドロップダウンリストから AI対応 RFプロファ
イルを選択して、現在の AI RFプロファイルに置き換えます。

c) AI RFプロファイルが作成されていない場合は、[Action]列の下にある 3つのドットをクリックして
新しい AI RFプロファイルを作成するか、現在の RFプロファイルと AI設定をコピーします。

d) [Select AI RF Profiles to assign]ウィンドウの [Create a new AI RF Profile to apply]リンクから AI RFプロ
ファイルを作成することもできます。詳細については、AI無線周波数プロファイルの作成（53ペー
ジ）を参照してください。

ステップ 6 [Details of selected AI RF Profile]ウィンドウで、AI対応RFプロファイルの [AI Settings]、[Common Settings]、
および [Assignment]の詳細を確認します。

AI拡張 RRMの計算は 30分ごとに発生します。RRMの決定は、計算後に更新され、デバイ
スにプッシュされます。

（注）
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ステップ 7 [Summary]ウィンドウで、[Task Details]、[Select Locations to Assign AI RF Profiles]、[Select AI RF Profiles
to assign]を確認します。

ステップ 8 [Deploy the AI RF Profiles]ウィンドウで、プロファイルを今すぐ展開する（[Now]）か、後でスケジュー
ルするかを選択します。

ステップ 9 [Continue]をクリックします。
タスク完了AI RF Profiles Assigned]ウィンドウが開きます。

ステップ 10 メニューアイコン（ ）をクリックして、[Activities] > [Tasks]の順に選択します。

ステップ 11 [Tasks]ウィンドウで、タスクのリンクをクリックします。

slide-in paneに、[Assigned Building(s)]、[Selected AI RF Profile]、および [Selected AI RF Profile]が表示され
ます。

既存の AI RFプロファイルへの場所の割り当て
次の手順では、既存の AI RFプロファイルに場所を割り当てる方法について説明します。

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[AI RF Profile]タブをクリックします。
[AI RF Profile]テーブルに、作成された AI RFプロファイルの数が一覧表示されます。

ステップ 5 AI RFプロファイルの [Action]列の下にある 3つのドットをクリックします。

ステップ 6 ドロップダウンリストから [Assign Location]を選択します。

[Manage Location Assignment]ウィンドウが開きます。

ステップ 7 [Search]フィールドに名前を入力してサイトを検索するか、[All Sites]を展開してサイトを選択します。

•サイト階層は、AI対応の場所を示しています。

• AIプロファイルの対象とならないサイトまたは建物は無効になっています。

•建物の下のフロアは選択できません。AI対応 RFプロファイルに建物を選択すると、そ
の下のフロアが自動的に割り当てられます。

（注）

同じワイヤレスコントローラが他の建物を管理している場合は、[Confirm Impacted Sites]ウィンドウが開
きます。

ステップ 8 確認し、[Confirm]をクリックして、選択したサイトを AI対応 RFプロファイルに割り当てます。
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ステップ 9 [Assign]をクリックします。

[Download a Backup of Current RF Settings]ウィンドウが開き、選択した建物全体の RF設定のバックアッ
プをダウンロードできます。

ステップ 10 （任意）バックアップリンクをクリックして、.csvファイルをローカルマシンにダウンロードします。

ステップ 11 [Confirm]をクリックします。

ステップ 12 表示される確認ウィンドウで、[Confirm]をクリックします。

[AI RF Profile]テーブルでは、AI RFプロファイルに割り当てられた場所が [Mapped Buildings]列の下に
表示されます。

次のタスク

AI RFプロファイル対応建物のデバイスのプロビジョニング

次の手順では、AI RFプロファイルを展開するためにロケーション全体のデバイスをプロビ
ジョニングする方法について説明します。

1. メニューアイコン（ ）をクリックして、[Provision] > [Network Devices] > [Inventory]の
順に選択します。

[Inventory]ウィンドウの [Device]テーブルには、検出された AI RFプロファイルに関連付
けられたデバイスが一覧表示されます。

2. プロビジョニングする AI RFプロファイルに関連付けられたデバイス名の横にあるチェッ
クボックスをオンにします。

3. [Actions]ドロップダウンリストから、[Provision] > [Provision Device]を選択します。

4. すべての手順を実行し、[Summary]ステップで [Deploy]をクリックします。

5. [Summary]ウィンドウで、デバイスにプッシュされる残りのネットワーク設定を確認しま
す。詳細については、ワイヤレスデバイスプロビジョニングの概要を参照してください。

既存の AI RFプロファイルへの場所の割り当ての解除
次の手順では、既存のAI RFプロファイルから場所の割り当てを解除する方法について説明し
ます。

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。
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ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Wireless Radio Frequency Profile]エリアで、[AI RF Profile]タブをクリックします。
[AI RF Profile]テーブルに、作成された AI RFプロファイルの数が一覧表示されます。

ステップ 5 AI RFプロファイルの [Action]列の下にある 3つのドットをクリックします。

ステップ 6 ドロップダウンリストから [Unassign Location]を選択します。

[Unassign AI RF Profile]ウィンドウが開きます。

ステップ 7 サイトの横にあるチェックボックスをオンにして、AI RFプロファイルの割り当てを解除します。

ステップ 8 [Select from available RF Profiles]オプションボタンをクリックして、選択した場所に割り当てる使用可能
な RFプロファイルを選択します。

ステップ 9 [Select RF Profile to Replace]ドロップダウンリストから、RFプロファイルを選択します。

[Select RF Profile to Replace]ドロップダウンリストには、AI RFプロファイルと基本 RFプロファイルが
表示されます。

ドロップダウンリストから基本的な RFプロファイルを選択すると、[Confirm Impacted Sites]ウィンドウ
で、同じワイヤレスコントローラが他のサイトを管理しているかどうかが検証されます。

[Confirm Impacted Sites]ウィンドウを確認し、[Confirm]をクリックして、選択したサイトを選択した RF
プロファイルに割り当てます。

ステップ 10 [Upload a CSV with RF settings back]をクリックして、ローカルマシンから RF設定のバックアップをアッ
プロードします。

ステップ 11 [Choose a file]をクリックして CSVファイルをインポートするか、CSVファイルをドラッグアンドド
ロップエリアにドラッグアンドドロップします。

CSVファイルの最大サイズは 10 MBです。（注）

アップロードされた CSVファイルから、選択したロケーション名に基づく RF設定が見つかった場合、
[Confirm RF Settings for Selected Locations]ウィンドウに [Location]と [Matched RF Profiles]が表示されま
す。

ステップ 12 [Confirm RF Settings for Selected Locations]ウィンドウを確認し、[Confirm]をクリックします。

ステップ 13 [Unassign]をクリックします。

ステップ 14 確認ウィンドウで、[Continue]をクリックします。

ステップ 15 メニューアイコン（ ）をクリックして、[Activities] > [Tasks]を選択して、AI RFプロファイルタスク
への次回、進行中、完了、および失敗したロケーションの割り当て解除を表示します。

次のタスク

AI RFプロファイル対応建物のデバイスのプロビジョニング

次の手順では、AI RFプロファイルが割り当てられたロケーション全体にデバイスをプロビ
ジョニングして、AI RFプロファイルを展開する方法について説明します。
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1. メニューアイコン（ ）をクリックして、[Provision] > [Network Devices] > [Inventory]の
順に選択します。

[Inventory]ウィンドウの [Device]テーブルには、検出された AI RFプロファイルに関連付
けられたデバイスが一覧表示されます。

2. プロビジョニングする AI RFプロファイルに関連付けられたデバイス名の横にあるチェッ
クボックスをオンにします。

3. [Actions]ドロップダウンリストから、[Provision] > [Provision Device]を選択します。

4. すべての手順を実行し、[Summary]ステップで [Deploy]をクリックします。

5. [概要]ウィンドウで、デバイスにプッシュされる残りのネットワーク設定を確認します。
詳細については、ワイヤレスデバイスプロビジョニングの概要を参照してください。

基本無線周波数プロファイルをAI無線周波数プロファイルにアップグ
レードする

始める前に

前提条件を満たしていることを確認します。詳細については、AI無線周波数プロファイルを
設定するための前提条件（53ページ）を参照してください。

AI拡張RRMサービスにサイトをオンボードするには、次のサービスの少なくとも 1つを有効
にする必要があります。

•フレキシブルラジオアサインメント（FRA）

•動的チャネル割り当て（DCA）

•伝送パワーコントロール（TPC）[でんそうぱわーこんとろーるTPC]

•動的帯域幅選択（DBS）

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 AI RFプロファイルにアップグレードする基本RFプロファイル名の横にあるチェックボックスをオンにし
ます。

ステップ 5 [Action]ドロップダウンリストから、[Upgrade to AI]を選択します。

ステップ 6 確認ウィンドウで [Yes]をクリックします。

ステップ 7 [Edit AI RF Profile]ウィンドウで、AI RFプロファイル設定を構成します。詳細については、AI無線周波数
プロファイルの作成（53ページ）を参照してください。
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AP承認リストの作成
許可されたAPのリストをCisco DNA Centerで設定できます。Cisco DNA Centerは、次のタイプ
の AP認証をサポートします。

•ローカル認証：ローカルデータベースに対する認証に、AP MACアドレス、シリアル番
号、またはその両方を使用します。

• AAA認証：認証に AAAサーバーのリストを使用します。

シスコワイヤレスコントローラをプロビジョニングするときに、AP認証リストを選択でき
ます。シスコワイヤレスコントローラは、AP認証リストに存在するAPからの認証要求のみ
にしか応答しません。

• AP認証にMACアドレスとシリアル番号の両方が必要な場合は、両方がAP認証リストに
追加されていることを確認してください。ワイヤレスコントローラにプロビジョニングさ

れたAP認証リストに認証に必要なエントリが揃っていない場合、その APはネットワー
クに入れません。

•メッシュ AP（MAP）の場合、AP認証用のMACアドレスを追加する必要があります。

• Cisco AireOSワイヤレスコントローラの場合、Cisco DNA CenterはMACアドレスの AP
しか認証しません。MACアドレスとシリアル番号の両方を設定した場合、Cisco AireOS
ワイヤレスコントローラはMACアドレスのみを使用します。

• Cisco Catalyst 9800シリーズワイヤレスコントローラの場合、Cisco DNA Centerは Cisco
IOS 17.5以降を搭載したワイヤレスコントローラの AP認証リストしかサポートしませ
ん。

（注）

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Authorization List]テーブルで [Add]をクリックします。

ステップ 5 [AP Authorization List] slide-in paneで、AP承認リストの名前を入力します。

ステップ 6 ローカル認証を構成するには、次の手順を実行します。

a) [Local Auth]タブで、[Configure Local Authorization]チェックボックスをオンにします。
b) [Type]エリアで、認証タイプを選択します。

• AP MACアドレスを設定するには、[Mac Address]をクリックします。

• APシリアル番号を設定するには、[Serial Number]をクリックします。

c) APのMACアドレスまたはシリアル番号のデータを入力するには、次のいずれかを実行します。
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• AP MACアドレスまたはシリアル番号を個別に認証リストに追加するには、[Add]をクリックしま
す。[AP Entry]フィールドにデータを入力します。

•データを含むCSVファイルをアップロードするには、[Upload]をクリックします。ダイアログボッ
クスで、次の操作を実行します。

1. ドラッグアンドドロップエリアにCSVファイルをドラッグアンドドロップします。または、
[Choose a file]をクリックし、ローカルに保存されている CSVファイルを参照して選択しま
す。

CSVファイルがない場合は、[Download]をクリックして、編集およびアップロー
ドできる CSVファイルをダウンロードします。

（注）

2. [Save]をクリックします。

d) （任意）認証にMACアドレスとシリアル番号の両方を使用するには：

1. [Mac Address]をクリックし、AP MACアドレスデータ（6.c（69ページ））を入力します。

2. [Serial Number]をクリックし、APシリアル番号データ（6.c（69ページ））を入力します。

ステップ 7 AAA認証を設定するには、次の手順を実行します。

a) [AAA Auth]タブで、[Configure AAA Authorization]チェックボックスをオンにします。
b) AAAサーバの AP認証要件に基づいて、次のいずれかを実行します。

• AAAサーバがAP認証にMACアドレスのみを使用する場合は、[Authorize AP against MAC Address]
チェックボックスをオンにします。

• AAAサーバーがAP承認にシリアル番号のみを使用する場合は、[Authorize AP against Serial Number]
チェックボックスをオンにします。

• AAAサーバーがAP承認にMACアドレスとシリアル番号の両方を使用する場合は、[Authorize AP
against MAC Address]チェックボックスと [Authorize AP against Serial Number]チェックボックスの
両方をオンにします。

c) APエントリを AP認証リストに追加するには、次のいずれかを実行します。

•必要な APエントリの横にあるプラスアイコン（ ）をクリックします。

• APエントリをクリックし、[Add Selected]をクリックします。

複数の APエントリを選択するには、Shiftキーを押しながら APエントリをクリック
し、[Add Selected]をクリックします。

（注）

•すべての APエントリを AP認証リストに追加するには、[Add All]をクリックします。[Search]
フィールドを使用して、APエントリをフィルタ処理できます。

ステップ 8 [Save]をクリックします。
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AP認証リストの編集または削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Authorization List]テーブルで、編集または削除する認証リスト名の横にあるチェックボックスをオン
にします。

• AP認証リストを編集するには、[Edit]をクリックします。[AP Authorization List] slide-in paneで、必要
に応じて設定を編集し、[Save]をクリックします。詳細については、AP承認リストの作成（69ペー
ジ）を参照してください。

• AP認証リストを削除するには、[Delete]をクリックしてから [Yes]をクリックします。

アンカーグループの作成

最大 3つのシスコワイヤレスコントローラでアンカーグループを作成し、アンカーの優先順
位を設定できます。次のデバイスをアンカーとして追加できます。

• Cisco DNA Centerによって管理されているシスコワイヤレスコントローラ。

• Cisco DNA Center（外部のワイヤレスコントローラ）によって管理されていないシスコ
ワイヤレスコントローラ

アンカーグループには 1つ以上のアンカーを追加する必要があります。（注）

アンカーの優先順位によって、アンカー間のトラフィック共有が決まります。

•均等共有：すべてのアンカーの優先順位が同じ場合（例：1、1、および 1）。

•部分共有：複数のアンカーの優先順位が同じ場合（例：1、1、および 2）。

•順次共有：アンカーの優先順位が順次である場合（例：1、2、および 3）。

ステップ 1 メニューアイコン（ ）をクリックして、 [Design] > [Network settings]の順にクリックします。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Anchor Group]テーブルで、[Add]をクリックします。

ステップ 5 [Anchor Group]スライドインペインの [Anchor Group Name]フィールドに、アンカーグループ名を入力し
ます。
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ステップ 6 管理対象ワイヤレスコントローラをアンカーとして追加するには、[Add Managed WLC]をクリックし、
[Add Managed WLC]ダイアログボックスで次の手順を実行します。

a) アンカーを追加するデバイス名の横にあるチェックボックスをオンにします。

デバイスを検索するには、[Search Table]の検索フィールドにデバイスの名前の一部または完全な名
前を入力し、Enterキーを押します。

b) [Add]をクリックします。

ステップ 7 （任意）外部のワイヤレスコントローラをアンカーとして追加するには、[Add External WLC]をクリッ
クし、[Add External WLC]ダイアログボックスで次の手順を実行します。

a) [Device Name]フィールドに、デバイス名を入力します。
b) [Device Series]ドロップダウンリストからデバイスシリーズを選択します。
c) [Peer IP Address]フィールドに、ピアの IPアドレスを入力します。
d) （任意） [NAT IP Address]フィールドに、ネットワークアドレス変換（NAT）IPアドレスを入力し
ます。

e) [MAC Address]フィールドに、デバイスのMACアドレスを入力します。
f) [Mobility Group Name]フィールドに、モビリティグループ名を入力します。
g) （任意） [Hash]フィールドに、Cisco Catalyst 9800シリーズワイヤレスコントローラのハッシュを
入力します。

このフィールドは、Cisco Catalyst 9800-CLワイヤレスコントローラでのみ使用できます。（注）

h) [Add]をクリックします。

ステップ 8 （任意）既存の外部のワイヤレスコントローラをアンカーとして追加するには、[Add Existing External
WLC]をクリックし、[Add Existing External WLC]ダイアログボックスで次の手順を実行します。

a) アンカーを追加するデバイス名の横にあるチェックボックスをオンにします。

デバイスを検索するには、[Search Table]の検索フィールドにデバイスの名前の一部または完全な名
前を入力し、Enterキーを押します。

b) [Add]をクリックします。

ステップ 9 （任意）アンカーの優先順位を設定するには、[Priority Order]ドロップダウンリストからアンカーワイ
ヤレスコントローラの優先順位を選択します。

ステップ 10 [Save]をクリックします。

アンカーグループを編集または削除

ステップ 1 メニューアイコン（ ）をクリックして、 [Design] > [Network settings]の順にクリックします。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [Anchor Group]テーブルで、編集または削除するアンカーグループの横にあるチェックボックスをオンに
します。
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•アンカーグループを編集するには、[Edit]をクリックします。[Anchor Group]スライドインペインで、
アンカーを構成し、[Save]をクリックします。詳細については、アンカーグループの作成（71ペー
ジ）を参照してください。

•アンカーグループを削除するには、[Delete]をクリックし、[Yes]をクリックします。

APプロファイル
APプロファイルは、プラグアンドプレイ（PnP）、Cisco Advanced Wireless Intrusion Prevention
System（aWIPS）、不正管理、およびメッシュネットワークのAP認証設定を統合します。AP
プロファイルを使い、APの管理とプロビジョニングで行えます。Cisco DNA Centerでは、Cisco
IOS XEデバイスと Cisco AireOSデバイスにデフォルトの APプロファイルが設定されていま
す。デフォルトのAPプロファイルは編集できますが、削除することはできません。Cisco IOS
XEおよび Cisco AireOSデバイスのカスタム APプロファイルを作成することもできます。AP
プロファイルをサイトに割り当てるには、それをワイヤレスネットワークプロファイルに関

連付けます。

Cisco IOS XEデバイスの APプロファイルの作成

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Profile]テーブルで、[Add]にカーソルを合わせて [AP Profile for IOS-XE]を選択します。

ステップ 5 [Create Access Point Profile]ウィンドウで、APプロファイルの名前を入力します。

ステップ 6 （任意） APプロファイルの説明を入力します。

ステップ 7 この APプロファイルがリモートテレワーカー APまたは Cisco OfficeExtend AP用である場合は、[Remote
Teleworker]チェックボックスをオンにします。

リモートテレワーカー対応の APプロファイルは、次の設定をサポートしていません。

• aWIPSアプリケーション

•不正の検出

•メッシュ

•電源

（注）

ステップ 8 次のタブで必要な設定を行います。

a) [Management]：詳細については、「Cisco IOS XEデバイスの APプロファイルの管理設定を行う（74
ページ）」を参照してください。

b) [Security]：詳細については、「Cisco IOS XEデバイスの APプロファイルのセキュリティ設定を行う
（75ページ）」を参照してください。
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c) [Mesh]：詳細については、「Cisco IOS XEデバイスのAPプロファイルのメッシュ設定を行う（76ペー
ジ）」を参照してください。

d) [Power]：詳細については、「Cisco IOS XEデバイスの APプロファイルの電力設定を行う（77ペー
ジ）」を参照してください。

e) [Additional]：詳細については、「Cisco IOS XEデバイスの APプロファイルの追加設定を行う（79
ページ）」を参照してください。

ステップ 9 [Save]をクリックします。

Cisco IOS XEデバイスの APプロファイルの管理設定を行う

この手順を使用して、Cisco IOS XEデバイスの APプロファイルに以下を設定します。

• PnP要求プロセス中に APを安全にオンボードするための認証設定。Cisco DNA Centerの
グローバルレベルまたはサイトレベルの階層で行われた認証設定に基づいて、APを要求
する際に PnPから 802.1x（Dot1x）サプリカントと証明書がプッシュされます。APは、
Cisco ISEでの認証に 802.1xサプリカントを使用します。

• APの n日目の認証に関する認証設定。

•コンソールアクセス、SSH、および Telnetのログイン情報。

• Cisco Discovery Protocol（CDP）を有効にし、隣接デバイスからAPを検出できるようにす
る。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for IOS-X]）で、[Management]タブをクリックします。

ステップ 2 [Access Points Authentication]エリアで、認証方式を選択します。

Cisco DNA Centerは、AP PnP要求と n日目の認証のときにこの認証方式を使用します。認証方
式を変更すると、PnP要求プロセスでオンボードされたAPのサービスに影響します。認証方式
を変更する場合は、PnP要求プロセスでオンボードされたAPの工場出荷時設定へのリセットを
実行します。APが別の Extensible Authentication Protocol（EAP;拡張可能認証プロトコル）方式
で参加する場合、EAP方式は選択した認証方式によって変わります。

（注）

選択可能な認証方式は次のとおりです。

• [NO-AUTH]：デフォルトの認証方式。

• [EAP-TLS]：EAP-Transport Level Security（EAP-TLS）では、証明書ベースの認証を使用します。

• [EAP-PEAP]：EAP-Protected Extensible Authentication Protocol（EAP-PEAP）では、相互認証が提供さ
れ、脆弱なユーザーログイン情報の機密性と整合性が保証されます。またこのプロトコルでは、自身

をパッシブ（盗聴）およびアクティブ（中間者）攻撃から保護し、セキュアに暗号キー関連情報を生

成します。EAP-PEAPは、IEEE 802.1X標準および RADIUSプロトコルと互換性があります。

[EAP-PEAP]を選択した場合は、ユーザー名とパスワードを入力します。Cisco DNA Centerは証明書を
生成し、PnP要求プロセス中にその証明書を適用します。
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• [EAP-FAST]：EAP-Flexible Authentication through Secure Tunneling（EAP-FAST）では、相互認証が提供
され、共有秘密を使用してトンネルが確立されます。このトンネルは、パスワードに基づく弱い認証

方式を保護するために使用されます。Protected Access Credentials（PAC）キーと呼ばれる共有秘密は、
トンネルのセキュリティを確保するときにクライアントとサーバを相互認証するために使用されます。

[EAP-FAST]を選択した場合は、ユーザー名とパスワードを入力します。Cisco DNA Centerは証明書を
生成し、PnP要求プロセス中にその証明書を適用します。

ステップ 3 [SSH and Telnet]エリアで、次のように設定します。

a) （任意） [SSH]トグルボタンをクリックし、SSHのログイン情報を設定します。
b) （任意） [Telnet]トグルボタンをクリックし、Telnetのログイン情報を設定します。
c) [Username]フィールドに、デバイスの認証に使用する名前を入力します。

ユーザー名にスペースや山カッコ（< >）は使用できません。

SSHと Telnetを無効にした場合、[Username]フィールドの指定は任意となります。（注）

d) [Password]フィールドに、デバイスの認証に使用するパスワードを入力します。

SSHと Telnetを無効にした場合、[Password]フィールドの指定は任意となります。（注）

e) [Enable Password]フィールドにパスワードを入力し、CLIでより高い権限レベルを有効にします。

SSHと Telnetを無効にした場合、[Enable Password]フィールドの指定は任意となります。（注）

ステップ 4 [Cisco Discovery Protocol (CDP) State]エリアで [CDP State]トグルボタンをクリックし、CDPを有効または
無効にします。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco IOS XEデバイス
の APプロファイルの作成（73ページ）を参照してください。

Cisco IOS XEデバイスの APプロファイルのセキュリティ設定を行う

この手順を使用して、Cisco IOS XEデバイスの APプロファイルに以下を設定します。

• Cisco Advanced Wireless Intrusion Prevention System（aWIPS）とフォレンジックキャプチャ
により、侵入の脅威を検出して軽減します。Cisco DNA Centerは、Cisco IOS XEリリース
17.3.1以降を実行しているデバイスの aWIPSをサポートします。

•不正検出により、システム管理者からの明示的な許可を得ずにネットワークにインストー
ルされている APを検出できます。Cisco DNA Centerは、Cisco IOS XEリリース 17.4以降
を実行しているデバイスの不正検出をサポートします。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for IOS-XE]）で、[Security]タブをクリックします。
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ステップ 2 [aWIPS and Forensic Capture Enablement]エリアで、次のように設定します。

a) [aWIPS]トグルボタンをクリックし、aWIPSを有効または無効にします。
b) [Forensic Capture Enablement]トグルボタンをクリックし、フォレンジックキャプチャを有効または無効
にします。

[Forensic Capture Enablement]トグルボタンを使用するには、[aWIPS]トグルボタンを有効に
する必要があります。

（注）

ステップ 3 [Rogue Detection]エリアで、[Rogue Detection]トグルボタンをクリックして不正検出を有効または無効にし
ます。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco IOS XEデバイス
の APプロファイルの作成（73ページ）を参照してください。

Cisco IOS XEデバイスの APプロファイルのメッシュ設定を行う

この手順を使用して、Cisco IOS XEデバイスの APプロファイルのメッシュ設定を行います。

始める前に

メッシュアクセスポイント（MAP）のMACアドレスを AP承認リストに追加してください。
詳細については、AP承認リストの作成（69ページ）を参照してください。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for IOS-XE]）で、[Mesh]タブをクリックします。

ステップ 2 [Mesh]トグルボタンをクリックします。

[Mesh]トグルボタンを無効にすると、既存のカスタムメッシュ設定が削除され、APプロファ
イルがデバイスのデフォルトのメッシュプロファイルに関連付けられます。

（注）

ステップ 3 （任意） [Range - Root AP to Mesh AP (in feet)]フィールドに、ルートアクセスポイント（RAP）からネット
ワーク内のMAPまでの最大範囲（フィート）を入力します。有効な範囲は150フィートから132,000フィー
トです。

ステップ 4 （任意）バックホール無線を介したワイヤレスクライアント関連付けを許可するには、[Backhaul Client
Access]チェックボックスをオンにします。

バックホール無線には、大部分のMAPで 5 GHz帯が使用されます。バックホール無線は、バックホール
トラフィックとクライアントトラフィックの両方を伝送できます。

[Backhaul Client Access]チェックボックスがオフになっている場合、Cisco DNA Centerはバックホール無線
を介してバックホールトラフィックのみを送信し、クライアント関連付けは 2次的な無線のみを介して送
信されます。

ステップ 5 （任意） [RAP Downlink Backhaul]エリアで、必要なオプションを選択します。
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お住まいの国で [5 GHz]の使用が禁止されている場合は、[2.4 GHz]を選択してください。お住まいの国で
[5 GHz]の使用が許可されている場合でも、[2.4 GHz]の使用を検討してください。2.4 GHz無線は、より長
いメッシュまたはブリッジ距離をカバーできるためです。

RAP設定を [5 GHz]から [2.4 GHz]に変更すると、Cisco DNA Centerは RAPからすべてのMAP
に更新を伝播します。この時点で、MAPは 5 GHzネットワークから切断され、2.4 GHzネット
ワークに接続します。

（注）

ステップ 6 （任意） [Backhaul Data Rates]エリアで、[5GHz Band Radio Type]および [2.4GHz Band Radio Type]ドロッ
プダウンリストからインターフェイスレートを選択します。

有効なバックホールインターフェイスレートは、APに応じて、[802.11abg]、[802.11n]、[802.11ac]（5GHz
帯域無線のみ）、[802.11ax]、および [Auto]となります。バックホールは、AP間のワイヤレス接続を作成
します。利用可能な RFスペクトラムを効果的に使用するにはレート選択が重要です。このレートは、ク
ライアントデバイスのスループットにも影響を与える可能性があります

[Auto]データレートを使用すると、各リンクは、そのリンク品質に対して可能な限り最高のレートで到達
できます。

メッシュバックホールのデータレートは [Auto]に設定することをお勧めします。

ステップ 7 （任意） [Bridge Group]エリアの [Bridge Group Name]フィールドに、ブリッジグループ名（最大 10文字）
を入力します。

ブリッジグループ名によって、MAPの関連付けが制御されます。無線をグループ化すると、同じチャネル
上にあってもブリッジグループ名が異なる2つのネットワークは互いに通信できません。この設定はまた、
同一セクター（エリア）のネットワーク内に複数の RAPがある場合にも便利です。

ブリッジグループ名を入力しない場合、Cisco DNA Centerはメッシュプロファイルにデフォルトのブリッ
ジグループ名を使用します。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco IOS XEデバイス
の APプロファイルの作成（73ページ）を参照してください。

Cisco IOS XEデバイスの APプロファイルの電力設定を行う

この手順を使用して、Cisco IOS XEデバイスの APプロファイルに以下を設定します。

• AP電力プロファイル：APが必要な電力を受け取っていない場合、APはAP電力プロファ
イルの設定に基づいて、ディレーティング状態で機能します。詳細については、AP電力
プロファイルの作成（83ページ）を参照してください。

電力設定は、Cisco IOS XEリリース 17.10.1以降を実行している
シスコワイヤレスコントローラにのみ適用されます。

（注）
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•カレンダー電力プロファイル：省電力モードの APのカレンダー電力プロファイルを作成
できます。必要に応じて、複数の AP電力プロファイルを別のカレンダースケジュールに
マッピングできます。Cisco DNA Centerは、設定されたスケジュールに基づいて、AP電
力プロファイルで定義されたすべてのルールを同時に実行します。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for IOS-XE]）で、[Power]タブをクリックします。

ステップ 2 [AP Power Profile]エリアで、[Select Value]ドロップダウンリストから電力プロファイルを選択します。

（電力プロファイルを作成するには、[Create New]をクリックしてパラメータを設定します。詳細について
は、「AP電力プロファイルの作成（83ページ）」を参照してください。）

ステップ 3 [Calendar Power Profile]エリアで、次の手順を実行します。

a) カレンダー電力プロファイルを追加するには、[Add]をクリックします。[Add Calendar Power Profile]
エリアで、次の手順を実行します。

1. [Select Power Profile]ドロップダウンリストから電力プロファイルを選択します。

電力プロファイルを作成するには、[Create New]をクリックしてパラメータを設定します。詳細に
ついては、AP電力プロファイルの作成（83ページ）を参照してください。

2. APに電力プロファイルルールを適用するための繰り返し頻度を選択します。

• [Daily]：APに毎日電力プロファイルルールを適用します。

• [Weekly]：毎週選択した曜日に APに電力プロファイルルールを適用します。必要な曜日をク
リックして選択します。

• [Monthly]：毎月選択した日付にAPに電力プロファイルルールを適用します。必要な日付をク
リックして選択します。

3. 電力プロファイルルールの開始時刻と終了時刻を指定します。

4. [Save]をクリックします。

b) （任意）電力プロファイルルールを編集するには、対応する電力プロファイル名の横にあるチェック
ボックスをオンにし、[Edit]をクリックします。[Edit Power Profile] slide-in paneで、必要なパラメータ
を編集して [Save]をクリックします。

c) （任意）電力プロファイルを削除するには、対応する電力プロファイル名の横にあるチェックボック

スをオンにし、[Delete]、[Yes]の順にクリックします。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco IOS XEデバイス
の APプロファイルの作成（73ページ）を参照してください。
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Cisco IOS XEデバイスの APプロファイルの追加設定を行う

この手順を使用して、Cisco IOS XEデバイスの APプロファイルに以下を設定します。

•国コード：国コードがまだ設定されていないその他の地域（ROW）ドメインAPの国コー
ドを設定します。

国コードの設定は、すでに国コードが設定されている APには影
響しません。

（注）

•タイムゾーン：APのタイムゾーンを選択します。

•クライアント制限：許可されるクライアントの最大数を指定します。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for IOS-XE]）で、[Additional]タブをクリックします。

ステップ 2 [Country Code]エリアで、[Select Value]ドロップダウンリストから国コードが設定されていない ROW AP
の国を選択します。

ステップ 3 [Time Zone]エリアで、次のいずれかのオプションを選択します。

• [Not Configured]：APは UTCのタイムゾーンで動作します。
• [Controller]：APはシスコワイヤレスコントローラのタイムゾーンで動作します。
• [Delta from Controller]：APはワイヤレスコントローラのタイムゾーンからのオフセットで動作します。
次のオフセット値を設定します。

• [HH]：時間の値を入力します。有効な範囲は 12～ 14です。

• [MM]：分の値を入力します。有効な範囲は 0～ 59です。

ステップ 4 [Client Limit]エリアにクライアント数の上限値を入力します。有効な範囲は 0～ 1,200です。

次のタスク

APプロファイルに必要な設定をすべて指定したら、[Save]をクリックします。詳細について
は、Cisco IOS XEデバイスの APプロファイルの作成（73ページ）を参照してください。

Cisco AireOSデバイスの APプロファイルの作成

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Profile]テーブルで、[Add]にカーソルを合わせて [AP Profile for AireOS]を選択します。

ネットワークの設定

79

ネットワークの設定

Cisco IOS XEデバイスの APプロファイルの追加設定を行う



ステップ 5 [Create Access Point Profile]ウィンドウで、APプロファイルの名前を入力します。

ステップ 6 （任意） APプロファイルの説明を入力します。

ステップ 7 この APプロファイルがリモートテレワーカー APまたは Cisco OfficeExtend AP用である場合は、[Remote
Teleworker]チェックボックスをオンにします。

リモートテレワーカー対応の APプロファイルは、次の設定をサポートしていません。

• aWIPSアプリケーション

•不正の検出

•メッシュ

•電源

（注）

ステップ 8 次のタブで必要な設定を行います。

a) [Management]：詳細については、「Cisco AireOSデバイスの APプロファイルの管理設定を行う（80
ページ）」を参照してください。

b) [Security]：詳細については、「Cisco AireOSデバイスの APプロファイルのセキュリティ設定を行う
（81ページ）」を参照してください。

c) [Mesh]：詳細については、「Cisco AireOSデバイスのAPプロファイルのメッシュ設定を行う（81ペー
ジ）」を参照してください。

ステップ 9 [Save]をクリックします。

Cisco AireOSデバイスの APプロファイルの管理設定を行う

この手順を使用して、Cisco AireOSデバイスの APプロファイルに以下を設定します。

•コンソールアクセス、SSH、および Telnetのログイン情報。

• Cisco Discovery Protocol（CDP）を有効にし、隣接デバイスからAPを検出できるようにし
ます。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for AireOS]）で、[Management]タブをクリックします。

ステップ 2 [SSH and Telnet]エリアで、次のように設定します。

a) （任意） [SSH]トグルボタンをクリックし、SSHのログイン情報を設定します。
b) （任意） [Telnet]トグルボタンをクリックし、Telnetのログイン情報を設定します。
c) [Username]フィールドに、デバイスの認証に使用する名前を入力します。

ユーザー名にスペースや山カッコ（< >）は使用できません。

SSHと Telnetを無効にした場合、[Username]フィールドの指定は任意となります。（注）

d) [Password]フィールドに、デバイスの認証に使用するパスワードを入力します。
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SSHと Telnetを無効にした場合、[Password]フィールドの指定は任意となります。（注）

e) [Enable Password]フィールドにパスワードを入力し、CLIでより高い権限レベルを有効にします。

SSHと Telnetを無効にした場合、[Enable Password]フィールドの指定は任意となります。（注）

ステップ 3 [Cisco Discovery Protocol (CDP) State]エリアで [CDP State]トグルボタンをクリックし、CDPを有効または
無効にします。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco AireOSデバイス
の APプロファイルの作成（79ページ）を参照してください。

Cisco AireOSデバイスの APプロファイルのセキュリティ設定を行う

この手順を使用して、Cisco AireOSデバイスの APプロファイルの不正検出を設定します。不
正検出により、システム管理者からの明示的な許可を得ずにネットワークにインストールされ

ている APを検出できます。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for AireOS]）で、[Security]タブをクリックします。

ステップ 2 [Rogue Detection]エリアで、[Rogue Detection]トグルボタンをクリックして不正検出を有効または無効にし
ます。

次のタスク

APプロファイルのその他の必要な設定を行います。詳細については、Cisco AireOSデバイス
の APプロファイルの作成（79ページ）を参照してください。

Cisco AireOSデバイスの APプロファイルのメッシュ設定を行う

この手順を使用して、Cisco AireOSデバイスの APプロファイルのメッシュ設定を行います。

始める前に

MAPのMACアドレスを AP承認リストに追加してください。詳細については、AP承認リス
トの作成（69ページ）を参照してください。

ステップ 1 [Create Access Point Profile]ウィンドウ（[Design] > [Network Settings] > [Wireless] > [AP Profile]テーブル >
[Add] > [AP Profile for AireOS]）で、[Mesh]タブをクリックします。

ステップ 2 [Mesh]トグルボタンをクリックします。
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ステップ 3 （任意） [RAP Downlink Backhaul]エリアで、必要なオプションの横にあるオプションボタンをクリックし
ます。

お住まいの国で [5 GHz]の使用が禁止されている場合は、[2.4 GHz]を選択してください。お住まいの国で
[5 GHz]の使用が許可されている場合でも、[2.4 GHz]の使用を検討してください。2.4 GHz無線は、より長
いメッシュまたはブリッジ距離をカバーできるためです。

RAP設定を [5 GHz]から [2.4 GHz]に変更すると、Cisco DNA Centerは RAPからすべてのMAP
に更新を伝播します。この時点で、MAPは 5 GHzネットワークから切断され、2.4 GHzネット
ワークに接続します。

（注）

ステップ 4 （任意） [Bridge Group]エリアの [Bridge Group Name]フィールドに、ブリッジグループ名（最大 10文字）
を入力します。

ブリッジグループ名によって、MAPの関連付けが制御されます。無線をグループ化すると、同じチャネル
上にあってもブリッジグループ名が異なる2つのネットワークは互いに通信できません。この設定はまた、
同一セクター（エリア）のネットワーク内に複数の RAPがある場合にも便利です。

ブリッジグループ名を入力しない場合、Cisco DNA Centerはメッシュプロファイルにデフォルトのブリッ
ジグループ名を使用します。

次のタスク

APプロファイルに必要な設定をすべて指定したら、[Save]をクリックします。詳細について
は、Cisco AireOSデバイスの APプロファイルの作成（79ページ）を参照してください。

APプロファイルの編集または削除

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Profile]テーブルで、編集または削除する APプロファイル名の横にあるチェックボックスをオンにし
ます。

• APプロファイルを編集するには、[Edit]をクリックします。[Edit Access Point Profile] slide-in paneで、
必要に応じて設定を編集し、[Save]をクリックします。詳細については、Cisco AireOSデバイスの AP
プロファイルの作成（79ページ）およびCisco IOS XEデバイスの APプロファイルの作成（73ペー
ジ）を参照してください。

• APプロファイルを削除するには、[Delete]をクリックしてから [Yes]をクリックします。
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AP電力プロファイルの作成
Cisco IOS XEリリース 17.10.1以降を実行しているシスコワイヤレスコントローラの AP電力
プロファイルを作成できます。APプロファイルに関連付けることにより、AP電力プロファイ
ルを APに割り当てます。AP電力プロファイルの複数のルールを定義し、ルールの順序を指
定できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Power Profile]テーブルで、[Add]をクリックします。

ステップ 5 [Create Power Profile] slide-in paneで、AP電力プロファイルの名前を入力します。

ステップ 6 （任意） AP電力プロファイルの説明を入力します。

ステップ 7 AP電力プロファイルのルールを作成するには、[Add]をクリックします。

ステップ 8 [Add Rule]ダイアログボックスで、次の手順実行します。

a) [Interface]ドロップダウンリストからインターフェイスのタイプを選択します。
b) [Interface ID]ドロップダウンリストからインターフェイス IDを選択します。

使用可能なインターフェイス IDが 1つだけの場合、Cisco DNA Centerで使用可能なイン
ターフェイス IDが自動的に選択されます。

（注）

c) [Parameter]ドロップダウンリストからパラメータを選択します。

使用可能なパラメータが 1つだけの場合、Cisco DNA Centerで使用可能なパラメータが自
動的に選択されます。

（注）

d) [Parameter Value]ドロップダウンリストからパラメータ値を選択します。

使用可能なパラメータ値が 1つだけの場合、Cisco DNA Centerで使用可能なパラメータ値
が自動的に選択されます。

（注）

e) [Add]をクリックします。

ステップ 9 （任意） AP電力プロファイルの別のルールを作成するには、「ステップ 7（83ページ）」と「ステッ
プ 8（83ページ）」を繰り返します。

ステップ 10 （任意） [Rules]テーブルのルールの順序を更新するには、対応する アイコンをクリックし、ルール

を必要な位置にドラッグアンドドロップします。

ステップ 11 [Save]をクリックします。
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次のタスク

AP電力プロファイルと APプロファイルを関連付けます。詳細については、Cisco IOS XEデ
バイスの APプロファイルの作成（73ページ）を参照してください。

AP電力プロファイルの編集または削除

ステップ 1 メニューアイコン（ ）をクリックして、 [Design] > [Network settings]の順にクリックします。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、[Global]を選択します。

ステップ 4 [AP Power Profile]テーブルで、編集または削除する AP電力プロファイル名の横にあるチェックボックス
をオンにします。

• AP電力プロファイルを編集するには、[Edit]をクリックします。[Edit Power Profile] slide-in paneで、必
要に応じて説明、ルール、順序を編集し、[Save]をクリックします。詳細については、AP電力プロ
ファイルの作成（83ページ）を参照してください。

• AP電力プロファイルを削除するには、[Delete]をクリックしてから [Yes]をクリックします。

非ファブリック展開用の Ciscoセンサー SSIDのプロビジョニング
• Cisco DNA Centerセンサーは、Ciscoセンサープロビジョニングサービスセット識別子
（SSID）を使用して、プラグアンドプレイ（PnP）サーバーと通信し、テストを実行する
ための Day-0設定を取得します。

Ciscoセンサープロビジョニング SSIDは、センサーとして動作す
る APには適用されません。

（注）

•ファブリック展開の場合、Ciscoセンサープロビジョニング SSIDは、Cisco DNA Centerと
通信するためにインフラストラクチャ仮想ネットワークアクセスポイント（INFRAVN-AP）
プールにマッピングされます。

•次のプラットフォームは Ciscoセンサープロビジョニング SSIDをサポートしています。

• Cisco AireOSコントローラ

• Cisco Catalyst 9800シリーズワイヤレスコントローラ（ファブリック展開と非ファブ
リック展開の両方）

• CiscoセンサープロビジョニングSSIDは次のネットワークコントローラをサポートしてい
ます。

•クラウド向け Cisco Catalyst 9800ワイヤレスコントローラ
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• Cisco Catalyst 9800シリーズワイヤレスコントローラ

• Cisco AireOSコントローラ

次の手順で、非ファブリック展開の Ciscoセンサープロビジョニング SSIDを設定できます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 [SSID]テーブルから、 にカーソルを合わせて、[Enterprise]を選択します。

ワイヤレス SSIDワークフローが表示されます。

ステップ 4 [Sensor]フィールドを切り替えて、[Next]をクリックします。

SSIDのパラメータは自動的に入力され、編集できません。（注）

ステップ 5 [Next]をクリックします。

ステップ 6 [Wireless Profiles]画面で、[Profiles]のプロファイルを確認します。

[Edit Wireless Profile]ダイアログボックスが表示されます。

ステップ 7 [Fabric]で [Yes]を選択し、[Save]をクリックします。

「Success Profile sensorProfile selected」というメッセージが表示されます。

ステップ 8 [Finish]をクリックします。

ステップ 9 メニューアイコン（ ）をクリックして、[Provision] > [Network Devices] > [Inventory]の順に選択しま
す。

ステップ 10 デバイスを確認し、[Actions]ドロップダウンメニューから [Provision] > [Provision Device]の順に選択し
ます。

ステップ 11 [Assign Site]、[Configuration]、[Model Configuration]、[Advanced Configuration]、および [Summary]で詳細
を確認します。各画面で [Next]をクリックしてください。

ステップ 12 [Deploy]をクリックします。

[Provision Device]ダイアログボックスが表示されます。

ステップ 13 [Now]を選択し、[Apply]をクリックします。

結果：「Task Scheduled view status in Tasks」というメッセージが右下隅に表示されます。

バックホールの設定の管理

ワイヤレスセンサのバックホール設定を表示、作成、管理するには、次の手順を実行します。

ワイヤレスセンサーには、Cisco DNA Centerと通信するためのバックホールSSIDが必要です。
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ステップ 1 メニューアイコン（ ）をクリックして、[Assurance] > [Manage] > [Sensors]の順に選択します。

[Sensor List]ウィンドウが表示されます。

ステップ 2 [Settings]タブにカーソルを合わせ、[Backhaul Settings]を選択します。

ステップ 3 バックホール SSIDを追加および管理するには、次の手順を実行します。

a) [Add Backhaul]をクリックします。

[Create Sensor Backhaul SSID Assignment]ウィンドウが表示され、[Wired Backhaul]と [Wireless Backhaul]
の 2つの領域が表示されます。

b) [Settings name]フィールドでバックホール SSIDの名前を入力します。
c) [Wired Backhaul]領域で、次を設定します。

• [Level of Security]：選択した SSIDで使用されている暗号化と認証タイプが表示されます。使用可
能なセキュリティのオプションは次のとおりです。

• [802.1x EAP]：Extensible Authentication Protocol（EAP）を有線 LANで渡すために使用される
規格。

• [Open]：セキュリティまたは認証は使用されません。

• [EAP Method]：[802.1x EAP]を選択した場合は、ドロップダウンリストからユーザ認証に次のいず
れかの EAP方式を選択する必要があります。

• [EAP-FAST]：指定されたフィールドにユーザ名とパスワードを入力します。

• [PEAP-MSCHAPv2]：指定されたフィールドにユーザ名とパスワードを入力します。

• [EAP-TLS]：[Enroll Using Certificate Bundle]または [Enroll Using SCEP]を選択します。

[Enroll Using Certificate Bundle]を選択した場合は、[Certificate Bundle]の下にあるドロップダ
ウン矢印をクリックし、[+ Add New Certificate Bundle]をクリックして、ユーザ名と証明書バ
ンドルパスワードを入力します。

• [PEAP-TLS]：[Enroll Using Certificate Bundle]または [Enroll using SCEP]を選択します。

[Enroll Using Certificate Bundle]を選択した場合は、[Certificate Bundle]の下にあるドロップダ
ウン矢印をクリックし、[+ Add New Certificate Bundle]をクリックして、ユーザ名と証明書バ
ンドルパスワードを入力します。

d) [Wireless Network Name（SSID）]領域で、ワイヤレスネットワーク（SSID）を選択し、次を設定しま
す。

• [Level of Security]：選択した SSIDで使用されている暗号化と認証タイプが表示されます。使用可
能なセキュリティのオプションは次のとおりです。

• [WPA2 Enterprise]：拡張可能認証プロトコル（EAP）（802.1x）を使用してより高レベルのセ
キュリティを実現し、リモート RADIUSサーバでネットワークユーザを認証および承認しま
す。
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• [WPA2-Personal]：パスフレーズまたは事前共有キー（PSK）を使用して、良好なセキュリティ
を実現します。ワイヤレスネットワークにアクセスするパスキーがあれば誰でも使用できま

す。

[WPA2 Personal]を選択した場合は、[Passphrase]テキストボックスにパスフレーズを入力しま
す。

• [PSK Format]：使用可能な事前共有キーの形式は次のとおりです。

• [ASCII]：ASCII PSKパスフレーズをサポートします。

• [HEX]：64文字の HEXキー PSKパスワードをサポートします。

• [Open]：セキュリティまたは認証は使用されません。

e) [Save]をクリックします。

ステップ 4 既存のバックホール設定を編集するには、次の手順を実行します。

a) バックホール設定のチェックボックスをオンにします。

b) [Actions]ドロップダウンリストにカーソルを合わせて、[Edit]を選択します。

ステップ 5 バックホール設定を削除するには、次の手順を実行します。

a) バックホール設定のチェックボックスをオンにします。

b) [Actions]ドロップダウンリストにカーソルを合わせて、[Delete]を選択します。

Cisco Connected Mobile Experiencesの統合について
Cisco DNA Centerは、ワイヤレスマップのためのCisco Connected Mobile Experiences（CMX）の
統合をサポートしています。CMXを統合すると、Cisco DNA Centerユーザーインターフェイ
ス内で、フロアマップ上でのワイヤレスクライアント、不正アクセスポイントおよび干渉源の

正確な場所を把握できます。

CMXの設定は、ユーザーの要件に応じて、グローバルレベルで、あるいはサイト、ビルディ
ング、またはフロアレベルで作成できます。小企業の場合はグローバルレベル（親ノード）で

CMXを割り当てることができます。すべての子ノードが親ノードから設定を継承します。中
企業の場合はビルディングレベルで CMXを割り当てることができ、小企業の場合はフロア
レベルで CMXを割り当てることができます。

セキュリティ上の理由から、CMXは匿名にする必要があります。（注）

Cisco CMX設定の作成

ステップ 1 メニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択します。
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ステップ 2 [External Services]セクションで、[CMX Servers/Cisco DNA Spaces]をクリックします。

[CMX Servers/Cisco DNA Spaces]ウィンドウが開きます。

ステップ 3 [CMX Servers]テーブルから、[Add]をクリックします。

ステップ 4 [Add CMX Server]スライドインペインで、次のフィールドに入力します。

• [IP Address]：CMX Web GUIの有効な IPアドレスを入力します。

• [User Name]：CMX Web GUIのユーザー名を入力します。

• [Password]：パスワードログイン情報を入力します。

• [SSH User Name]：CMX管理者のユーザー名を入力します。

• [SSH Password]：CMX管理者のパスワードログイン情報を入力します。

CMXが到達可能であることを確認してください。（注）

ステップ 5 [Add]をクリックします。

CMXサーバーが正常に追加されました。

ステップ 6 CMXサーバーをサイト、建物、またはフロアに割り当てるには、メニューアイコンをクリックし、
[Design] > [Network Settings]の順に選択します。

ステップ 7 [Wireless]タブをクリックします。

ステップ 8 [Global]または必要なエリア、建物、フロアを左側の階層ツリーから、。

ステップ 9 [CMX Servers/Cisco DNA Spaces]セクションで、ドロップダウンリストを使用して、CMXサーバーを選
択します。

ステップ 10 [Save]をクリックします。

[Create CMX Settings]ウィンドウが開きます。

CMXの追加後に [Network Hierarchy]ページのフロアに変更を加えた場合、その変更は自動的に CMXと
同期されます。

CMXが同期されると、Cisco DNA Centerはクライアントロケーションを CMXに照会し、その場所がフ
ロアマップに表示されます。

ステップ 11 フロアマップでは、次のことを実行できます。

•クライアントの場所を表示します。これは青色のドットとして表示されます。

• AP上にカーソルを移動します。ダイアログボックスは、[Info]、[Rx Neighbor]、[Clients]タブで表示
されます。詳細については、各タブをクリックしてください。[Device 360]をクリックして、デバイ
ス 360ウィンドウを開き、問題を表示します。問題をクリックして、問題の場所とクライアントデ
バイスの場所を表示します。

• APをクリックして、APに関する詳細を含むサイドバーを開きます。

• Intelligent Captureと CMXを統合するときにリアルタイムでクライアントトラッキングを実行しま
す。
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ステップ 12 変更を加えたときにCMXがダウンした場合は、手動で同期する必要があります。同期するには、[Network
Hierarchy]ページで、左側の階層ツリーで変更を加えた建物やフロアの隣にある省略記号 の上にカー

ソルを置き、[Sync：CMX Server/Cisco DNA Spaces]を選択して、変更を手動でプッシュします。

ステップ 13 CMXサーバーの詳細を編集する場合や CMXサーバーを削除する場合は、次の手順を実行します。

a) メニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択します。

b) [External Services]セクションで、[CMX Servers/Cisco DNA Spaces]をクリックします。
c) 編集する CMXサーバーを選択して変更を加え、[Update]をクリックします。
d) 削除する CMXサーバーを選択し、[Delete]をクリックします。
e) [OK]をクリックして削除を実行します。

CMX認証に失敗した場合

• Cisco DNA Centerで CMX設定の作成時に指定したログイン情報で、CMX Web GUIにロ
グインできるか確認します。

• SSHを使用して CMXコンソールにログインできるかどうかを確認します。

• CMX GUIの APIドキュメンテーションリンクを使用して CMX REST APIを使用できるか
どうかを確認します。

クライアントが Cisco DNA Centerフロアマップに表示されない場合

•特定のフロアのシスコワイヤレスコントローラが CMXで設定されており、アクティブ
になっているか確認します。

• CMX GUIでフロアマップにクライアントが表示されるか確認します。

• Cisco DNA Centerマップ APIを使用して、フロアにクライアントをリスト表示します。
curl -k -u <user>:<password> -X GET
/api/v1/dna-maps-service/domains/<floor group
id>/clients?associated=true

Cisco Spacesの統合について
現実の世界で事業を行っている企業は、これまで、建物内の人々や接続されたアセットの動き

を可視化できませんでした。Cisco Spacesは、基盤となるすべてのシスコワイヤレスネット
ワークによって提供されるロケーション感知インテリジェンスを使用し、データをビジネス対

応の洞察に変換することで、この物理的な死角の問題を解決します。

Cisco DNA Centerは、Cisco Spacesの統合をサポートします。Cisco Spacesを統合すると、Cisco
DNA CenterのGUI内で、フロアマップ上でのワイヤレスクライアント、不正AP、および干渉
源の正確な場所を把握できます。Cisco Spacesの設定は、ユーザーの要件に応じて、グローバ
ルレベルで、あるいはサイト、ビルディング、またはフロアレベルで作成できます。
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現在、Cisco DNA Centerと Cisco Spacesの統合は、自動マップエクスポートとロケーション階
層の同期のみに制限されています。この統合では、キャプティブポータルベースの認証機能は

サポートされません。

（注）

Cisco Spacesと Cisco DNA Centerの統合

Cisco Spacesと Cisco DNA Centerを統合するには、次の手順を使用します。

ステップ 1 Cisco Spacesクライアントをオンボードします。

a) 電子メール IDを使用して Cisco Spacesにログインし、[Continue]をクリックします。
b) [Select Customer]ドロップダウンリストから、Cisco DNA Centerインスタンスの Spacesテナント（たと
えば、dna-center-dev-US）を選択し、[Proceed]をクリックします。

c) Cisco Spaces GUIでメニューアイコンをクリックして、[Setup] > [Wireless Networks]の順に選択しま
す。

d) [Connect your wireless network]ウィンドウで、『Cisco Spaces Configuration Guide』に記載されている手
順 1〜 3を実行して、Cisco Spacesクライアントをオンボードします。

『Cisco Spaces Configuration Guide』には、[Need Help?] > [View Configuration Steps]の下にある右側の
ペインからアクセスできます。

ステップ 2 Cisco DNA Centerを Cisco Spacesに登録します。

a) 電子メール IDを使用して Cisco Spacesにログインし、[Continue]をクリックします。
b) [Select Customer]ドロップダウンリストから、Cisco DNA Centerインスタンスの Spacesテナント（た

とえば、dna-center-dev-US）を選択し、[Proceed]をクリックします。
c) Cisco Spaces GUIでメニューアイコンをクリックし、[Integrations] > [Cisco DNA Center]の順に選択

します｡
d) [DNAC Integration]ウィンドウで、[Create Token]をクリックします。

[Create new token]ダイアログボックスが開きます。

e) [Instance Name]フィールドに、インスタンスの一意の名前を入力し、[Create Token]をクリックしま
す。

インスタンスの新しいトークンが開きます。

f) トークンの右側までスクロールし、[Copy Token]を選択します。
g) トークンを Cisco DNA Center GUIに貼り付けるには、Cisco DNA Centerにログインします。
h) Cisco DNA Center GUIでメニューアイコン（ ）をクリックして、[System] > [Settings]の順に選択

します。

i) 左側のナビゲーションウィンドウで、下にスクロールして [CMX Servers/Cisco DNA Spaces]を選択し
ます。

[CMX Servers/Cisco DNA Spaces]ウィンドウが開きます。
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j) [Cisco DNA Spaces]エリアで、[Activate]を選択します。

[Integrate Cisco DNA Spaces]ダイアログボックスが開きます。

k) [Tenant Token]テキストボックスで、Ctrl+Vキーを押して Cisco Spacesからコピーしたトークンを貼
り付け、[Connect]をクリックします。

[Success]ダイアログボックスに次の情報が表示されます。
This cluster is integrated with Cisco Spaces successfully.

[CMX Servers/Cisco DNA Spaces]ウィンドウに緑色の ✔ [Activated] ステータスが表示され、Cisco
Spacesで選択した（dna-center-dev-USなどの）テナントが [Tenant]フィールドに表示されます。

ステップ 3 Cisco Spacesを Cisco DNA Centerのサイトに割り当てます。

a) Cisco DNA Center GUIでメニューアイコン（ ）をクリックして、[Design] > [Network settings]。

b) [Wireless]タブをクリックします。
c) 左側の階層ツリーから、[Global]か、Cisco Spacesに割り当てるエリア、ビルディング、またはフロア
を選択します。

d) [CMX Servers/Cisco DNA Spaces]セクションのドロップダウンリストを使用して（DNA Spaces -
dna-center-dev-USなどの）サイトを選択します。

e) [保存（Save）]をクリックします。

ステップ 4 Cisco Spacesを使用して Cisco DNA Centerのサイトをモニターします。

a) Cisco DNA Center GUIでメニューアイコン（ ）をクリックして、[Design] > [Network Hierarchy]。

b) 左側の階層ツリーから、[Global]か、Cisco Spacesにモニターさせるエリア、ビルディング、またはフ
ロアを選択します。

Cisco DNA Centerにより、サイト情報が Cisco Spacesに自動的に展開されます。

c) Cisco Spacesが動作していることを確認するには、次の図に示すように、Cisco Spaces/CMXステータス
アイコンがモニターするフロアに表示されていることを確認します。
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図 1 : Cisco Spacesステータスアイコン

FlexConnect VLANの設定
次の FlexConnect VLAN設定を指定することができます。

• [Native VLAN]：FlexConnectグループが APとシスコワイヤレスコントローラの間で管
理トラフィックを伝送できるようにします。

• [AAA Override VLAN]：ローカルでスイッチングされるクライアントの動的VLAN割り当
てを提供します。

これらの設定をグローバルレベルで適用して、サイト、ビルディング、またはフロアレベルの

設定をオーバーライドすることができます。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network settings]。

ステップ 2 [Wireless]タブをクリックします。

ステップ 3 左側の階層ツリーから、必要なサイトを選択します。

• [Global]：すべてのサイトに対してグローバルレベルで VLANを設定します。

•エリア、ビルディング、またはフロア：選択したレベルでのみ VLANを設定します。

ステップ 4 [Native VLAN ID]フィールドに、VLAN IDの値を入力します。有効な範囲は 1～ 4094です。

ステップ 5 [AAA Override VLAN]設定の場合は、VLAN IDと VLAN名のマッピングを、対応する [VLAN ID]フィー
ルドと [VLAN Name]フィールドに入力します。さらにマッピングを追加するには、[Add]アイコンをク
リックします。
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FlexConnect展開に対して定義できる VLANマッピングの最大数は 16です。ただし、Cisco
Catalyst9800シリーズワイヤレスコントローラの場合、この数には、デフォルトのWLANVLAN
と、AAAによってプッシュされた VLANが含まれます。

（注）

ステップ 6 [保存（Save）]をクリックします。

次のタスク

ワイヤレスネットワークプロファイルを作成するか、SSIDを設定します。

•ワイヤレスネットワークプロファイル：ワイヤレスネットワークプロファイルを作成す
る場合は、[FlexConnect Local Switching]チェックボックスがオンになっていることを確認
します。詳細については、ワイヤレス用のネットワークプロファイルの作成を参照してく

ださい。

• [SSID]：SSIDを設定する場合は、エンタープライズワイヤレスネットワーク用 SSIDの
作成（20ページ）およびゲストワイヤレスネットワークの SSIDの作成（30ページ）
を参照してください。

保存済みの FlexConnect VLAN設定をワイヤレスコントローラで設定するには、ワイヤレスコ
ントローラをプロビジョニングする必要があります。詳細については、Cisco AireOSコント
ローラのプロビジョニングまたはCisco Catalyst 9800シリーズワイヤレスコントローラの設定
とプロビジョニングを参照してください。

ワイヤレスコントローラのプロビジョニング後に、コントローラに関連付けられているAPを
プロビジョニングする必要があります。

ワイヤレスメッシュネットワークについて

シスコワイヤレスメッシュネットワーク内のアクセスポイント（AP）は、次の 2つの方法の
いずれかで動作します。

•ルートアクセスポイント（RAP）：それぞれの場所で有線ネットワークに接続します。

•メッシュアクセスポイント（MAP）：ワイヤレスで通信し、安全でスケーラブルなワイヤ
レス LANを提供します。

すべての APはMAPとして設定され、出荷されています。APを RAPとして使用するには、
RAPとして再設定する必要があります。すべてのメッシュネットワークで、少なくとも1つの
RAPがあることを確認します。

（注）

RAPは、それぞれの場所で有線ネットワークに接続します。すべてのダウンストリーム AP
は、MAPとして動作し、ワイヤレスリンクを使用して通信します。
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MAPと RAPはいずれもWLANクライアントアクセスを提供します。ただし、一般に、RAP
の場所は高い確率でクライアントアクセスの提供に向いていません。

MAPから CAPWAPセッションを終端させるオンサイトコントローラがある建物もあります
が、CAPWAPセッションはワイドエリアネットワーク（WAN）を介してコントローラにバッ
クホールできるため、それは必須要件ではありません。

Ciscoワイヤレスバックホールネットワークでは、トラフィックをMAPとRAPの間でブリッ
ジできます。このトラフィックは、ワイヤレスメッシュによってブリッジされている有線デバ

イスからのトラフィックか、MAPからのCAPWAPトラフィックになります。このトラフィッ
クは、ワイヤレスバックホールなどのワイヤレスメッシュリンクを通過する際に必ずAES暗
号化されます。

メッシュネットワークの詳細については、最新の『Cisco Wireless Mesh Access Points, Design and
Deployment Guide』を参照してください。

AP Configuration

メッシュネットワークモードで使用する既存の APがある場合は、最初に [Configure Access
Point]ワークフローを使用して APモードを [Bridge]または [Flex+Bridge]に変更する必要があ
ります。詳細については、APワークフローの設定を参照してください。
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APを [Bridge]モードまたは [Flex+Bridge]モードに設定すると、[AP 360]ウィンドウにメッシュ
設定が表示されます。この時点で、APを新しい設定でプロビジョニングする必要があります。
シスコ製 APのプロビジョニング：Day 1 APプロビジョニング。

シスコワイヤレスコントローラの設定

メッシュネットワークの場合は、コントローラで許可 APのリストを設定する必要がありま
す。コントローラは、許可リストに含まれているMAPからの要求にのみ応答します。

Cisco DNA Centerは、Cisco IOSリリース 17.5以降を実行している Cisco Catalyst 9800シリーズ
ワイヤレスコントローラでの承認リストの設定をサポートしています。

（注）

Cisco AireOSワイヤレスコントローラと Cisco Catalyst 9800シリーズワイヤレスコントローラ
の両方で、Cisco DNA Centerを使用してブリッジグループ名（BGN）とRAPダウンリンクバッ
クホールメッシュの設定を指定することができます。Cisco Catalyst 9800シリーズワイヤレス
コントローラでは、MAPの最大範囲、バックホールクライアントアクセス、およびバック
ホールデータレートを設定することもできます。

これらの設定は、[Create AP Profile]ウィンドウでグローバルサイトに対して指定されます。詳
細については、Cisco IOS XEデバイスのAPプロファイルのメッシュ設定を行う（76ページ）
およびCisco AireOSデバイスの APプロファイルのメッシュ設定を行う（81ページ）を参照
してください。

証明書失効確認の設定
次の手順を使用して、証明書失効確認を設定します。

ステップ 1 メニューアイコン（ ）をクリックして、[Design] > [Network Settings] > [Security and Trust]の順に選択
します。

ステップ 2 左側の階層ツリーから、サイト、ビルディング、またはフロアを選択します。

ステップ 3 [Revocation Check]ドロップダウンリストでは、[Revocation - Check: CRL None]がデフォルトで選択されて
います。

ステップ 4 失効確認をスキップするには、[Revocation - Check: None]を選択し、[Save]をクリックします。
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翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。


